An analysis of high school students' self-efficacy in second language acquisition through digital language lab learning: Exploring new pathways to proficiency

Lorna A. Fairess
Rowan University

Follow this and additional works at: https://rdw.rowan.edu/etd

Part of the Bilingual, Multilingual, and Multicultural Education Commons, Language and Literacy Education Commons, and the Secondary Education Commons

Let us know how access to this document benefits you - share your thoughts on our feedback form.

Recommended Citation
https://rdw.rowan.edu/etd/2720

This Dissertation is brought to you for free and open access by Rowan Digital Works. It has been accepted for inclusion in Theses and Dissertations by an authorized administrator of Rowan Digital Works. For more information, please contact LibraryTheses@rowan.edu.
AN ANALYSIS OF HIGH SCHOOL STUDENTS’ SELF-EFFICACY IN SECOND LANGUAGE ACQUISITION THROUGH DIGITAL LANGUAGE LAB LEARNING: EXPLORING NEW PATHWAYS TO PROFICIENCY

by

Lorna A. Fairess

A Dissertation

Submitted to the
Department of Educational Services and Leadership
College of Education
In partial fulfillment of the requirement
For the degree of
Doctor of Education
at
Rowan University
June 2019

Dissertation Advisor: Carol C. Thompson, Ph.D.
Dedication

I would like to dedicate this manuscript to my husband, Steve, who has always been supportive in my educational pursuits. He patiently listened to me share what I was learning and my ups and downs, peer-edited my papers, and took care of our youngest, Connor, when I was attending classes and researching. Additionally, I would like to thank my mother Gloria who, as a retired elementary teacher, has forever encouraged me to persevere through her positive words and deeds. She has been a constant source of inspiration and always will be. Also, I would like to thank my relatives (Eric Fairess, Blake Fairess, Connor Fairess, Keith and Judy Turgiss, Dr. Krystal Turgiss, Dr. Jennifer Turgiss and Bruce Turgiss, and Joan and Woodrow Fairess) and fellow educators (Lisa Raible, Renee Toliver, Terri Riches, Dr. Justin Smith, Janey Fryer, Brian Pistone, Ryann DiNatale, James Goetschius, Jenn Tharp, and Christine Garrido) who often encouraged me in various ways to forge ahead in my pursuit of answers in my research. Lastly, I am grateful to Dr. Carol L. Birnbohm and high school principal, Mr. Matthew Campbell, for providing the resources and time necessary to conduct this study.
Acknowledgments

I would like to express my appreciation to Dr. Carol C. Thompson for her guidance and help throughout this research process. The skills and knowledge I have gained as a result of her teaching and mentorship I will take with me into my next professional endeavor. I look forward to whatever challenges lie ahead knowing that I am prepared to meet them head-on. Furthermore, I would like to thank Dr. Marilyn Manley, Chair of Rowan University’s world languages department, for her help with the project and expertise in second language acquisition and learning. Additionally, I would like to thank Dr. Jo Ann Manning for her unwavering support and knowledge of qualitative research methods. She always prompted me with helpful suggestions and critical thinking along this journey. Last, but not least, I would like to thank Dr. Deborah Gaspar from the Rowan University Campbell Library for her encouragement and assistance with linguistic databases. All of these individuals are experts in their fields of study and are amazing educators who helped me realize this goal.
Abstract

Lorna A. Fairess
AN ANALYSIS OF HIGH SCHOOL STUDENTS’ SELF-EFFICACY IN SECOND LANGUAGE ACQUISITION THROUGH DIGITAL LANGUAGE LAB LEARNING: EXPLORING NEW PATHWAYS TO PROFICIENCY
2018-2019
Carol C. Thompson, Ph.D.
Doctor of Education

Students are often faced with barriers acquiring a second language due to various factors such as language anxiety, learning differences, and a lack of speaking time with the language. The purposes of this qualitative study were to: a) determine students’ perceptions of the effectiveness of a digital language lab on their self-efficacy in second language acquisition at the secondary level, and b) discern teachers’ perceptions of the effectiveness of the lab as well as recommendations for best practices in teacher training and implementation. Twenty-seven Italian and Spanish students and 12 world language teachers from two fairly rural high schools in Northeastern United States comprised the participants in this qualitative study. Data sources included: student interviews, a student survey, a teacher questionnaire, class observations, and material culture. Using grounded theory, it became evident students’ self-efficacy in language acquisition could be positively influenced for various leveled learners via practice opportunities available with the lab. Furthermore, educators shared lessons, created user guides, and taught others how to use the program. Thus, the study revealed not only the manner a blended resource provided students an anxiety-free tool to explore the target language, but also it showed how teachers embraced an opportunity to train other teachers as a preferred model of professional development when challenged with implementing a new technology throughout world language classrooms.
# Table of Contents

Acknowledgments.............................................................................................................. iv
Abstract ............................................................................................................................... v
List of Figures ........................................................................................................................ xii
List of Tables ........................................................................................................................ xiv
Chapter 1 ............................................................................................................................... 1
    Literacies for a New Age ............................................................................................... 4
    The Five Cs ..................................................................................................................... 5
    “Can Do” Statements ................................................................................................. 7
    Problem Statement ........................................................................................................ 8
    Transformational Leadership ...................................................................................... 9
    Ensuring Equity ........................................................................................................... 10
        ReLANpro: Exploring a Possible Solution ........................................................... 13
    Rationale and Significance ......................................................................................... 19
    Statement of Purpose ................................................................................................. 20
    New Jersey Department of Education’s Student Learning Standards ..................... 23
    One Regional High School District ........................................................................... 24
    Overview of Methods ..................................................................................................... 25
    Research Questions ....................................................................................................... 26
    Role of the Researcher ................................................................................................. 27
    Researcher Assumptions .............................................................................................. 28
    Definitions of Key Terminology ................................................................................. 29
    Summary ....................................................................................................................... 29
# Table of Contents (Continued)

Chapter 2 ....................................................................................................................... 30

Introduction .................................................................................................................. 30

A Historical Look at Second Language Learning ...................................................... 31

CALL, MALL, and ReLANpro .................................................................................... 35

Self-Efficacy and Bandura’s Social Cognitive Theory ............................................. 38

Other Constructs Influencing Language Learning .................................................. 39

  Self-Regulation .......................................................................................................... 39

  Metacognition ............................................................................................................. 40

  Motivation .................................................................................................................. 40

  Growth Mindset ......................................................................................................... 42

  Attribution .................................................................................................................. 42

  Language Anxiety ....................................................................................................... 43

Technological Approaches to Language Learning .................................................... 43

  Blended Learning ....................................................................................................... 43

  Implementation Considerations .................................................................................. 44

  Teachers’ Perceptions ................................................................................................. 44

  Blended Learning in Action ....................................................................................... 45

Technology Providing Pathways to Learning ............................................................. 46

  Multi-Modality .......................................................................................................... 46

  Visual Literacy ............................................................................................................. 48

  Differentiated Instruction .......................................................................................... 51

  Assessment .................................................................................................................. 52
Table of Contents (Continued)

The Importance of Feedback ................................................................. 52
Second Language Acquisition Theory .................................................. 53
Focus on Communication – The Ultimate Goal ..................................... 56
Summary ............................................................................................. 63

Chapter 3 ............................................................................................. 65
Introduction ......................................................................................... 65
Rationale for Research Approach ......................................................... 65
Research Questions ........................................................................... 65
Research Design .................................................................................. 66
Research Setting and Context ............................................................... 66
Research Sample and Data Sources ..................................................... 67
Subject Recruitment ........................................................................... 67
Consent Procedures ............................................................................. 68
Subject Costs and Compensation ......................................................... 68
Data Collection Methods ..................................................................... 69
Data Analysis Methods ...................................................................... 72
Issues of Trustworthiness .................................................................... 73
  Validity, Credibility, and Trustworthiness Relating to Data Collection... 73
  Validity, Credibility, and Trustworthiness Relating to Data Analysis .... 73
Limitations and Delimitations ............................................................... 74
Summary ............................................................................................. 74

Chapter 4 ............................................................................................. 75
# Table of Contents (Continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>75</td>
</tr>
<tr>
<td>Student Self-Efficacy</td>
<td>77</td>
</tr>
<tr>
<td>Practice</td>
<td>86</td>
</tr>
<tr>
<td>Technology</td>
<td>94</td>
</tr>
<tr>
<td>Quality of Program</td>
<td>97</td>
</tr>
<tr>
<td>Issues With Implementation</td>
<td>97</td>
</tr>
<tr>
<td>Growth Mindset of Educators</td>
<td>97</td>
</tr>
<tr>
<td>Assessment</td>
<td>101</td>
</tr>
<tr>
<td>Teacher Persistence With Implementation Efforts</td>
<td>106</td>
</tr>
<tr>
<td>Summary</td>
<td>110</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>113</td>
</tr>
<tr>
<td>Introduction</td>
<td>113</td>
</tr>
<tr>
<td>Notable Findings</td>
<td>113</td>
</tr>
<tr>
<td>Contribution to Existing Studies</td>
<td>115</td>
</tr>
<tr>
<td>Research Questions Revisited</td>
<td>116</td>
</tr>
<tr>
<td>Discussion</td>
<td>117</td>
</tr>
<tr>
<td>Research Questions</td>
<td>117</td>
</tr>
<tr>
<td>Self-Efficacy</td>
<td>117</td>
</tr>
<tr>
<td>Feedback</td>
<td>117</td>
</tr>
<tr>
<td>Cultural Understanding</td>
<td>118</td>
</tr>
<tr>
<td>Practice</td>
<td>118</td>
</tr>
<tr>
<td>Language Anxiety</td>
<td>119</td>
</tr>
</tbody>
</table>
Table of Contents (Continued)

Differentiated Instruction.................................................................119
Interpersonal Communication............................................................120
Different Pathways...............................................................................120
Benefits to Students ............................................................................121
Benefits to Teachers ...............................................................................121
Areas of Concern ..................................................................................122
Teachers Training Teachers ..................................................................122
Implications............................................................................................123
Research..................................................................................................123
Recommendations..................................................................................125
Language Lab Implementation and Transformational Leadership........125
Conclusions.............................................................................................127
References..............................................................................................128
Appendix A: Definitions of Key Terminology.......................................140
Appendix B: Student Survey .................................................................148
Appendix C: Teacher Questionnaire......................................................150
Appendix D: Observation Protocol........................................................151
Appendix E: Student Interview Protocol..............................................152
Appendix F: Student Directions on Media Center Computers School A ..................................................153
Appendix G: Student Directions Classroom on Chrome books School A ..................................................154
Table of Contents (Continued)

Appendix H: Teacher User Guide for ReLANpro School A..................................156
Appendix I: Teacher User Guide for ReLANpro School B..................................158
Appendix J: Student Survey Responses.................................................................160
Appendix K: Teacher Usage and Administrator View of ReLANpro.......................168
Appendix L: ReLANpro Visitation March 2019.....................................................172
Appendix M: Teacher Directions for ReLANpro Upon Visitation.........................177
## List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1. Adapted from “Time as a Critical Component for Developing Language Performance”</td>
<td>11</td>
</tr>
<tr>
<td>Figure 2. ReLANpro Interface</td>
<td>14</td>
</tr>
<tr>
<td>Figure 3. ReLANpro Interface</td>
<td>15</td>
</tr>
<tr>
<td>Figure 4. ReLANpro Lessonsets</td>
<td>16</td>
</tr>
<tr>
<td>Figure 5. ReLANpro’s Bookmark Function</td>
<td>17</td>
</tr>
<tr>
<td>Figure 6. ReLANpro and Chrome Books</td>
<td>18</td>
</tr>
<tr>
<td>Figure 7. ReLANpro’s Subtitling Capability</td>
<td>19</td>
</tr>
<tr>
<td>Figure 8. Historical Evolution of Second Language Instructional Practices</td>
<td>37</td>
</tr>
<tr>
<td>Figure 9. Adapted from “Diagram of the Grounded Theory Process”</td>
<td>72</td>
</tr>
<tr>
<td>Figure 10. Participant Characteristics - Language of Study</td>
<td>78</td>
</tr>
<tr>
<td>Figure 11. Participant Characteristics - Level of Study</td>
<td>78</td>
</tr>
<tr>
<td>Figure 12. Participant Characteristics - Year of Course</td>
<td>79</td>
</tr>
<tr>
<td>Figure 13. AP Italian Class Mastery Objectives</td>
<td>87</td>
</tr>
<tr>
<td>Figure 14. Teacher Computer View of Paired Conversations</td>
<td>88</td>
</tr>
<tr>
<td>Figure 15. Teacher Offers Students Tips</td>
<td>89</td>
</tr>
<tr>
<td>Figure 16. AP Italian Student</td>
<td>90</td>
</tr>
<tr>
<td>Figure 17. Student Survey Response - Practice With ReLANpro</td>
<td>93</td>
</tr>
<tr>
<td>Figure 18. Student Responses - ReLANpro Ease of Use</td>
<td>101</td>
</tr>
<tr>
<td>Figure 19. Picture Prompt and ReLANpro Speaking Exercise</td>
<td>103</td>
</tr>
<tr>
<td>Figure 20. Student Use of ReLANpro and Chrome books</td>
<td>104</td>
</tr>
<tr>
<td>Figure</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td>Figure 21. Italian I Students</td>
<td>105</td>
</tr>
<tr>
<td>Figure 22. Teacher Letter to Peer</td>
<td>107</td>
</tr>
<tr>
<td>Figure 23. ReLANpro Representative Visit March 2019</td>
<td>109</td>
</tr>
</tbody>
</table>
# List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1. NCSSFL-ACTFL Can-Do Statements: Performance Indicators for Language Learners</td>
<td>7</td>
</tr>
<tr>
<td>Table 2. ACTFL Performance Descriptors for Language Learners</td>
<td>59</td>
</tr>
<tr>
<td>Table 3. Response by Italian Students - ReLANpro Ease of Use</td>
<td>80</td>
</tr>
<tr>
<td>Table 4. Response by Spanish Students - ReLANpro Ease of Use</td>
<td>81</td>
</tr>
<tr>
<td>Table 5. Italian and Spanish Students Year 1 to 4 - ReLANpro Ease of Use</td>
<td>82</td>
</tr>
<tr>
<td>Table 6. Response to ReLANpro Ease of Use by Instructional Level</td>
<td>82</td>
</tr>
<tr>
<td>Table 7. Teacher Responses to Open-Ended Question</td>
<td>91</td>
</tr>
<tr>
<td>Table 8. Student Interviews - Practice, Speaking, Reading, and Writing Number Incidences</td>
<td>92</td>
</tr>
<tr>
<td>Table 9. Student Interview and Teacher Questionnaire Participant Characteristics</td>
<td>93</td>
</tr>
<tr>
<td>Table 10. Teacher Questionnaire on ReLANpro 2018-2019</td>
<td>95</td>
</tr>
</tbody>
</table>
Chapter 1

World language educators are perpetually seeking the most effective instructional methods and resources in second language acquisition to promote student motivation and achievement, and keen insights in the field are constantly evolving. Many, for instance, have explored whether classroom environments should be more teacher-centered, student-centered, grammar-based, or proficiency-driven. Those preferring a teacher-centered approach have focused on instructional methodologies and content knowledge that can be imparted to the learner. On the other hand, educators opting for a student-centered approach have concentrated on the learner’s attainment of requisite skills in communication and his or her overall progression towards proficiency targets in second language acquisition. The latter approach defines a higher academic standard which today’s educators should be prompting students to achieve.

One way educators are encouraging student achievement in second language acquisition is through the introduction of various computer-assisted language learning formats to augment students’ overall learning experience. This qualitative study will examine the effects of the ReLANpro digital language lab on high school students’ self-efficacy in second language acquisition throughout Italian and Spanish classrooms in a fairly rural regional high school district in the Northeastern United States. District administration chose the ReLANpro digital language lab as it offered educators and students both a hardwired and wireless solution with various functions prompting listening, reading, writing, and speaking skills in the target language. The focus will be at the secondary level as this group traditionally has been overlooked in lieu of post-secondary learners. Moreover, secondary learners represent a population which typically
encounter more inequities in instruction. Consequently, the study will delve into students’ lived experiences and actual perspectives of the ReLANpro lab as it pertains to such language attitudes as self-efficacy, motivation, attribution, and language anxiety in the target language. Moreover, the study will reveal teachers’ overall perceptions of the effectiveness of the lab and recommendations for best practices in teacher training and implementation.

This introduction will: a) discuss the benefits of second language acquisition (SLA); b) describe the background of the problem; c) illuminate current issues of equity throughout world language programs; d) examine ReLANpro as a possible solution to the inequities; e) delineate research questions pertinent to the study; f) clarify the study’s rationale and purpose; g) describe transformational leadership as related to the study; h) depict the role of the researcher and existing assumptions; and, i) highlight the methods of the study. Throughout the introduction, the study’s scope will emerge.

Students today live in a world in which people communicate in multiple languages using a broad array of technological tools. The United States, ironically, still remains the only industrialized nation which allows students to graduate from high school without credits in a foreign language (World Languages and Cultures, 2013). In fact, only 10 states require some type of second language credits to graduate. Furthermore, in states requiring credits, districts may offer language study for students in middle school at age 14 which makes it increasingly difficult for learners to become proficient in a second language. This is in stark contrast to European countries in which students begin learning a second language as early as age three, and 52% of the population is multilingual (World
Languages and Cultures, 2013). Therefore, there exists a need to bolster foreign language programs throughout American schools as participants of an interconnected world.

In a fast-moving society, students who are proficient in a second language will reap many benefits. For instance, students will have an edge when applying for some kinds of jobs. In occupations dealing with marketing, sales, or technical support, an individual knowing a second language can add between 10% and 15% to his or her wage (Hazlehurst, 2010). Thus, it seems there is everything to gain and nothing to lose from promoting more robust programs in foreign language study.

Aside from career opportunities and monetary benefits, there are other advantages to learning a world language. For example, students have a chance to appreciate another culture as well as experience cognitive gains in problem-solving and creativity (Kibler, A. & Phillipose, S., 2013). Additionally, students may develop an understanding of cultural differences. This is so critical to adolescents who may demonstrate insensitivities, making ethnic slurs and posting inappropriate comments about their peers on social media. Studying and acknowledging the unique characteristics of other groups, then, students may become less egocentric and more accepting, well-rounded individuals. Hence, there are a myriad of advantages to learning a world language beyond career and financial gain.

Interestingly, in the American public school system, world language educators have experienced a paradigm shift regarding what constitutes the goal of instruction. Teachers in the 1960s and even into the 1970s embraced an audio-lingual method (ALM) of instruction which focused mainly on drill programs (Levy, 1997). With this method the teacher was the center of the lesson, imparting knowledge on the pupil via oral drills.
The aim at that time was to have students pronounce the language succinctly. Today’s emphasis, however, is on students’ ability to produce spontaneous, culturally appropriate language in meaningful authentic contexts. One way students are producing the language and practicing is digitally both inside and outside of the classroom. The aim of this qualitative study, then, will be to determine how student-centered environments supported by digital tools throughout a blended learning format influence opportunities for practice and student self-efficacy in second language acquisition.

**Literacies for a New Age**

Using a blended resource to augment instruction may assist students in promoting their literacy skills on a broad scale. Although literacy has commonly been known as one’s ability to read and write, twenty-first century advances in technology have demanded that individuals be adept in many competencies or literacies. As English is one of the most difficult languages to learn and is universal in nature, it is applicable to a discussion on foreign language learning and technological literacy. In fact, according to the National Council of Teachers of English (NCTE, 2016), literacies include: a) proficiency and fluency with the tools of technology; b) intentional cross-cultural connections and relationships with others to solve problems and strengthen independent thought; c) the designing and sharing of information for global communities to meet a variety of purposes; d) the management, analysis and synthesis of multiple streams of simultaneous information; e) the creation, critique, analysis, and evaluation of multimedia texts; and, f) the attention to the ethical responsibilities required by these complex environments. Therefore, students must be afforded different pathways or
opportunities in secondary environments to develop literacy skills to be prepared fully for the challenges of the future.

In a world-wide, interdependent arena, global communication, or the ability to provide and access information across cultures via speaking, listening, reading, and writing is paramount. The countries of the world are dependent upon one another for trade, security, and a plethora of other reasons. Consequently, literacies are very aligned with cultural and social contexts, and ultimately, world language acquisition and learning. Participants in this 21st century global society, then, must be able to demonstrate various skills or competencies to be successful. Language learning opportunities supported through technology should be standards-based, instructor-designed, learner-centered, and aimed at developing proficiency in the target language. These opportunities should be interactive, meaningful, and cognitively engaging learning experiences. Technology is best driven by the needs of the language learner, supporting the kinds of interactions students need to become college, career, life, and world-ready.

The Five Cs

The Standards for Foreign Language Learning in the 21st Century (1999), known as "The Five Cs", or communication, cultures, connections, comparisons, and communities, reflect the "what" (content) of world language learning and form the core of standards-based instruction in the classroom.

The communication standard stresses the use of language for communication in "real life" situations. It emphasizes "what students can do with language" rather than "what they know about language." Students are asked to communicate in oral and written form, interpret oral and written messages, and show cultural understanding when they
communicate, and present oral and written information to various audiences for a variety of purposes.

The second “C” stands for cultures. Cultural understanding is an important part of world languages education. Experiencing other cultures allows the student to develop a better understanding and appreciation of the relationship between languages and other cultures, as well as the student's native culture. Students become better able to understand other people's points of view, ways of life, and contributions to the world. A way this understanding forms is through the interaction of language and one’s social world or surroundings.

“Connections” continues the explanation of the Cs. World languages instruction must be connected with other subject areas. Content from other subject areas is integrated with world language instruction through lessons that are developed around common themes. Students are then encouraged to compare and contrast languages and cultures, the fourth “C”. They discover patterns, make predictions, and analyze similarities and differences across languages and cultures. Finally, students often come to understand their native language and culture better through such comparisons.

Extending learning experiences from the world language classroom to the home and multilingual and multicultural community emphasizes living in a global society, or the fifth “C”. To encourage this goal, educators may plan activities including: field trips, use of e-mail and the World Wide Web, clubs, exchange programs and cultural activities, school-to-work opportunities, and chances to hear speakers of other languages in the school and classroom. Thus, the Five Cs comprise the foundation of what an effective world language program should include.
“Can Do” Statements

The American Council on the Teaching of Foreign Languages (ACTFL) supports the Five Cs by structuring learning proficiencies as “Can Do” statements in which students can gauge their proficiency level and set goals. The statements are presented in a chart format with the three modes of communication (interpretive, interpersonal, and presentational) as well as the proficiency levels (novice to superior). Within each proficiency level, there are gradations of low, mid, and high. Each statement starts with the pronoun “I” which personalizes the statements for each learner. It is helpful to have such a guide which includes statements, proficiency levels, and gradations in learning.

World language teachers may use “Can Do” statements at the onset of instructional units to gauge student understanding of material and plan lessons appropriate to students’ proficiency levels. An example of “Can Do” statements for the intermediate learner for the interpretive, interpersonal, and presentational modes in communication and intercultural communication is depicted below (see Table 1).

Table 1

<table>
<thead>
<tr>
<th>NCSSFL-ACTFL Can-Do Statements: Performance Indicators for Language Learners</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication</strong></td>
</tr>
<tr>
<td><strong>Interpretive</strong></td>
</tr>
<tr>
<td><strong>Interpersonal</strong></td>
</tr>
</tbody>
</table>
Table 1 (continued)

<table>
<thead>
<tr>
<th>Communication</th>
<th>Proficiency Benchmark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentational</td>
<td>I can communicate information, make presentations, and express my thoughts about familiar topics, using sentences and series of connected sentences through spoken, written, or signed language.</td>
</tr>
<tr>
<td>Intercultural Communication</td>
<td></td>
</tr>
<tr>
<td>Investigate</td>
<td>In my own and other cultures, I can make comparisons between products and practices to help me understand perspectives.</td>
</tr>
<tr>
<td>Interact</td>
<td>I can interact at a functional level in some familiar contexts.</td>
</tr>
</tbody>
</table>

Note. Adapted from “NCSSFL-ACTFL Can-Do Statements: Performance Indicators for Language Learners”. Copyright 2017 by the American Council on the Teaching of Foreign Languages.

Although a first tendency might be for world language teachers to focus on subject content, verb conjugations, and vocabulary in instruction, it is essential for instructors to consider oral proficiency benchmarks regularly in lessons to maximize opportunities for students’ second language acquisition. Along with incorporating oral proficiency benchmarks in regular classroom routines, instructors should be well-versed in best practices in the field as well as key concepts that pertain to language learning. A digital language lab may be a helpful tool to shift the focus from learning isolated grammar principles to producing the language for different purposes and audiences.

**Problem Statement**

As educators navigate the shifting goal of world language instruction from recitation to proficiency, some are still faced with ongoing obstacles. For instance,
districts allot varying amounts of instructional time in second language study which makes promoting proficiency more complex. Additionally, some schools and ultimately teachers have greater access to resources and professional development than others which can present further inequities. Consequently, teachers do not have the same tools with which to work, and these differences can be hard for educators to manage. However, adept, instructional leaders can implement creative solutions to address these issues. A qualitative study, which traces the manner a versatile, blended resource is integrated into a world language program as well as students’ unique perspectives regarding their overall learning experience, may provide a useful model for districts seeking to add more rigor and equity in instruction.

In the following sections, I address the core characteristics of transformational leadership, the lack of contact time in world languages classrooms, and the ReLANpro digital language lab as a vehicle for change and equity.

**Transformational Leadership**

It is not enough to merely provide teachers a versatile resource. Educational leaders need to be change agents in the learning process. Therefore, their job is to provide teachers with the training and time necessary to acclimate to a new resource in order to build capacity to maximize opportunities for their students’ achievement. As teachers play a central role in this endeavor, supervisors must also provide a foundation for learning and ensure equitable practices exist. As such, truly effective educational leaders must seek ways to support their teachers in promoting marginalized groups and providing opportunities for equity. Thus, a study that explores ways to bring forth more equity in achievement, then, is a desirable prospect. Theoharis (2007, p. 231) found school
principals led with social justice by: a) raising student achievement, b) improving school structures, c) re-centering and enhancing staff capacity, and d) strengthening school culture and community. Similarly, Shields (2010, p. 558) contends that transformational leadership “begins with questions of justice and democracy, critiques inequitable practices, and addresses both individual and public good.” Using digital language labs, teachers may be more equipped to provide students with equitable opportunities for achievement and make language acquisition more accessible for specific learners.

**Ensuring Equity**

With the ReLANpro lab, students enrolled in large classes or those with Individualized Education Plans (IEPs) may be afforded more speaking time in the classroom. Therefore, although there are different factors at play when considering overall equity afforded the learner, one of the biggest involves the contact time students have in the target language. In a much broader sense, the contact time students have with the language and/or number of years of instruction can factor into proficiency. The ACFTL diagram below shows a Pre-K to 12 continuum with grade levels and realistic proficiency targets given the amount of instructional time afforded the learner (see Figure 1). The number of years of language instruction is depicted in the left-hand column with the grade level entry point. The columns to the right indicate the typical proficiency levels attainable given the number of years of instruction and entry point. Consequently, students who only have two years of instruction might only achieve a novice level of proficiency whereas students who have sixteen years of instruction (K-16) might be able to achieve an advanced level of proficiency. The chart, then, represents a helpful guideline for educators.
Students who achieve an advanced level of proficiency at the high school level have truly accomplished a great feat. Even prospective world language teachers in public schools are only required to achieve a score of advanced low on the Oral Proficiency Interview (OPI). The OPI is administered via the phone with the tester gradually increasing the level of difficulty and complexity of the discussion along the way for the prospective language instructor.

Oral and written input, then, are key to language acquisition (National Standards, 1999). Standard 1.2 of the communication goal emphasizes that students’ control over what they hear and read has an impact on their development of comprehension (Mills, Pajares, & Herron, 2006, p. 277). Long (1986) and Rivers (1981) further contend that a main goal for educators is to promote confidence in students’ ability to comprehend all kinds of input. The amount of input a student receives and how they process this input,
then, affects their social world and acquisition. A digital language lab may provide students with a vehicle for authentic opportunities for input. In turn, students’ output, or what they can produce as a result of input, is important to gauge on an ongoing basis.

To promote systemic change in schools, educators must lead with social justice in mind. In world language classrooms, students are also faced with significant barriers such as language anxiety which can prompt delays in learning and alter students’ expectations of their own language abilities in such areas as speaking (Horwitz, 2001; Sheen, 2008; MacIntyre & Gardner, 1994; Ellis, 2008; Tallon, 2011; Young, 1991). Although the definitions of language anxiety may differ slightly, the majority of researchers agree it is situation-specific and is connected to the language acquisition process. Consequently, it constitutes more of a psychological phenomenon which causes students to shut down during a certain learning task. This apprehension or tension prompts delays, affecting the learner’s feelings, perceptions, and self-confidence which ultimately can negatively alter achievement or progress towards learning goals. Consequently, this construct should be considered in specific terms and related to such tasks as speaking or reading in the target language.

Keeping in mind tasks in the classroom which are more performance-based, it is important to remember who the learners actually are. Today’s language classes are comprised of students with a broad array of abilities with some having Individualized Education Plans (IEPs) and learning differences. Accordingly, it is incumbent upon educational leaders to provide students increased access to practice opportunities and authentic experiences in world languages. Advocating for these students and
implementing strategic, programmatic decisions to provide more equity, leaders can make a marked difference.

Effective world language educators prompt their students regularly to speak in the target language for different purposes and audiences. ACTFL recommends that 90% or more of class time be conducted in the target language. Essentially, in a typical foreign language class, all students combined speak only 23.5% of the class time (DESI, 2006, p. 48-49). In a 45-minute long class, 23.5% equals approximately 10.5 minutes. As this number represents the speaking time of all students put together, the practice time speaking becomes less as the class size is increased. Moreover, in a traditional class with 30 students, 21 seconds is the total time speaking in front of a classroom audience whereas 11 minutes is the total time speaking using a digital language lab. In addition, with a language lab, students may speak simultaneously without distracting one another, among other advantages. The ReLANpro digital language lab may well serve as a way world language educators can promote proficiency and assist learners in producing the language who may be reluctant to do so.

**ReLANpro: exploring a possible solution.** The district in which this qualitative study took place opted for ReLANpro as the present company had no local representative, and a new solution was desired. As the ReLANpro lab provided different formats (wired or wireless) and various multi-modal functions, it seemed like a viable solution. At its most basic level, ReLANpro like other digital labs allows for: a) the integration of text, images, and video, b) the alteration of materials to fit teachers’ requirements, c) the recording of learners’ own voices which can be played back, d) the interaction among learners with the teacher storing results, e) the tracking of learners’
work via a teacher console with the instructor having the ability to intervene, and f) the students’ enjoyment of self-assessment and independent learning which includes access to resources outside of class. Thus, the lab offered various components to provide for the diverse learners in the district.

ReLANpro is different as it offers more functions than most labs in a few ways. For instance, the lab also allows for paired speaking and has an app which students can access at home on their phones. Additionally, as the system is Cloud-based, it is easily accessible from a variety of locations. Therefore, it offers more functions and versatility than other labs. Furthermore, although the interface is in English, it can be used to teach any language and is user-friendly with icons large enough to make navigating through the software easier (Burston, 2017) (see Figure 2).

![Figure 2. ReLANpro Interface. This screenshot shows the user interface, icons, and recording functions.](image.png)
The system is intended for usage in both wireless and hardwired networked computer labs and classrooms, yet it can be used off-site wherever there is a broadband Internet connection. Overall, it provides lesson authoring and functions that can be used to produce and distribute a broad range of exercises based on text, graphics, and audio-video prompts coupled with audio, video, and text-based student responses (see Figure 3).

Figure 3. ReLANpro Interface. This screenshot shows sample speaking and writing assignment for students.
Additionally, teachers see a separate screen from the students with lessonsets which helps with using the system (see Figure 4).

![ReLANpro Lessonsets](image)

*Figure 4.* ReLANpro Lessonsets. This screenshot shows lessonsets as teachers view them.

The system is set up to be very versatile, then, operating on PC, Mac, and allowing access from Android, iOS mobile, and Chrome devices (Burston, 2017). Network functions are controlled by a remote server as well as the storage and management of student/course information and lesson materials. Districts can apply for a
free license for ReLANpro BYOLL for one teacher and 30 students with one GB of space on the ReLANpro server. The lab also has a unique voice insert function called GAP which allows students and teachers to add spoken comments to any audio or video file in a simple and efficient manner. Students can record themselves responding to a native speaker, listen to their own recording and learn by comparing their input with the original. Teachers can insert questions into a topical news report, prompt students to translate a poem, carry out a mock job interview, or simply add instructions in just one click. As students use the GAP feature, bookmarks are created which enable the instructor to access only those points in the digital file he or she wants to listen to and assess. Teachers can also add feedback directly into the files at the bookmarked points for students to reflect upon (see Figure 5).

![Figure 5. ReLANpro’s Bookmark Function. Bookmarks assist teachers with finding specific audio files to grade.](image-url)
Students use chrome books in the world language classroom in conjunction with the ReLANpro app to complete listening and speaking assignments created and uploaded by the teacher (see Figure 6).

Figure 6. ReLANpro and Chrome Books. Students use ReLANpro software with chrome books in Spanish class to produce the language.

On media center computers, students use the lab to write subtitles to video prompts created and uploaded by the instructor (see Figure 7). With video prompts students can practice using reflexive verbs in the target language as they describe the various things SpongeBob does to get ready for work in the morning.
Overall, the program may allow students practice opportunities and offer teachers different ways to engage the learner while assessing student proficiency and language acquisition along the way.

**Rationale and Significance**

It is evident there is a need to explore students’ language attitudes in relation to technological tools in world language classrooms at the secondary level. In fact, 75% of studies have focused on post-secondary learners (Burston, 2017), and the majority of studies have been quantitative in nature. Therefore, qualitative investigations of students’ self-efficacy in second language acquisition have been understudied. It is important to examine, then, high school students’ experience with a blending learning resource as it may contribute to the existing body of knowledge. Furthermore, it could represent, to some degree, the extent of student engagement with a newly implemented program. Fundamentally, an exploration of this sort can only serve to enhance the overall quality of a world language program via prompting self-study and reflection. Furthermore, the investigation may prompt possible applications of the resource in other language areas.
Not only ESL, but also the district’s speech program and English offerings will be considered with respect to study findings.

**Statement of Purpose**

In this section I address the potential benefits of the study for learners as well as implications for teacher professional development upon implementing a new program. In subsequent sections, I explore how educators can act as transformational leaders via providing a blended resource which may prompt practice and equity in language learning. Considering the world language learner and his or her journey towards proficiency, this investigation will examine students’ perspectives of the ReLANpro digital language lab program as it relates to opportunities in reading, listening, speaking, and writing. The findings from the study will hopefully add new insights and contribute to the existing body of research in second language acquisition as the focus will be on the learner’s attitudes towards his or her own language experience via a qualitative analysis. I will share feedback from the study with the district’s curriculum director to inform future professional development needs. Additionally, I will relay the findings to the district’s sending schools and local universities to promote ongoing articulation with respect to the resource.

Implementing a new digital language lab in a world language department may also benefit teachers via fostering staff capacity. As teachers acclimate to a new resource and work collaboratively to problem-solve, they are open to new understandings (Lave & Wenger, 1991). In this manner they are actually operating within a Community of Practice (CoP). CoPs are important as stakeholders may dialogue more to solve problems and explore new techniques. Thus, they share a common interest in finding the most
effective ways to integrate the resource into instruction. It is through this process of sharing information and experiences that members learn from each other and have an opportunity to develop personally and professionally. The study will also reveal teachers’ perceptions of the lab and shed light on the effectiveness of the professional development training offered by the district to the staff in implementing the program.

The CoP structure allows for professional development to occur, yet in-service training has to be created to offer more powerful learning experiences over time. In fact, Yoon, Duncan, Lee, Scarloss, and Shapley (2007) found throughout three studies that professional development lasting 14 or fewer hours shows no effects on learning – the largest effects are for programs offering 30-100 hours spread out over six to twelve months. Therefore, the days of the standalone workshop model have long since passed. Rather, a new paradigm for professional development has emerged which favors more high-quality training centered on student learning (Stein, Smith, & Silver, 1999; Hawley & Valli, 1999; Blank, de las Alas, & Smith, 2007; Wenglishky, 2000). The training is geared towards active teaching, assessment, observation, and reflection rather than abstract discussions (Darling-Hammond & McLaughlin, 1995). Fortunately, the district provides common planning time (CPT) for teachers to collaborate, plan lessons, assess, and learn more about the functionality of the ReLANpro program. With this planning time, lead teachers may even travel to sister schools to provide training to fellow world language staff in a turnkey training format. Thus, finding ways to provide professional development to teachers to support a blended learning resource may forge more equity in the world languages classroom which is a worthwhile endeavor.
The effectiveness of teacher training on the program may influence student perspectives of the lab. As the teacher is the person who initiates the set-up of the program and communicates its purpose to the students, this step is very important. Moreover, student perspectives could be linked to the rigor and variety of lessons delivered by the teacher. Therefore, the study must also take into consideration the teacher’s ability to grow and adjust during the implementation of a new program.

Interestingly, Argyris and Schön (1974) assert when teachers operate within communities of practice and engage in meaningful professional development opportunities, they are more inclined to experience sustainable change and “double loop learning”.

Teachers must be open to change, try new techniques, and allow for new learning in order to facilitate the smooth adoption of a program such as ReLANpro. In fact, without such a commitment to test something out fully, there is rarely reliable outcomes to gauge. Along the lines of true learning and sustainable change, Argyris and Schön describe how with double loop or model two learning, the variables appeal to the multitude. There is also an absence of self-sealing, or the tendency to permit progressively more testing of assumptions and greater learning about one's effectiveness. Additionally, there is an emphasis on providing: a) valid information or data, b) free and informed choice, c) commitment to choice and monitoring of its implementation, d) jointly-controlled tasks, e) public testing of theories, f) open environments, and g) learning-oriented norms. Therefore, this model pairs well with the ReLANpro implementation and provides more growth for all stakeholders. As teachers become more trained and comfortable with the use of the lab as well as possible digital lessons to create, they will be better able to guide all students more effectively with the program.
New Jersey Department of Education’s Student Learning Standards

When implementing a new program to support instruction, it is paramount to keep in mind learning standards as a guideline along the way. The New Jersey Department of Education revised its mission, vision, and student learning standards for world languages to reflect 21st century goals for students. In its introduction Greer (2017) asserts:

New Jersey citizens are part of a dynamic, interconnected, and technologically-driven global society centered on the creation and communication of knowledge and ideas across geographical, cultural, and linguistic borders. (p. 1)

Additionally, the mission statement describes a main benefit of studying a world language:

The study of another language and culture enables individuals, whether functioning as citizens or workers, to communicate face-to-face and by virtual means in appropriate ways with people from diverse cultures. (p. 1)

According to Greer (2017), a globally literate person must: a) communicate in more than one language with the levels of language proficiency that are required to function in a variety of occupations and careers in the contemporary workplace, b) exhibit attitudes, values, and skills that indicate a positive disposition and understanding of cultural differences and enhance cross-cultural communication, and c) value language learning as a global literacy as well as for its long-term worth in fostering personal, work-related, and/or financial success in an increasingly interconnected world. These goals further substantiate the prospect of examining the effectiveness of a digital resource to build proficiency and cultural competence in students.
One Regional High School District

The study took place in a district that cares deeply about providing diverse programs and services to all learners. This is depicted via its commitment to academics, the arts, and athletics. The high school graduation rate exceeds 90%, and a large percentage of students progresses onto two and four-year colleges and universities. Furthermore, parents are actively involved in the school district and participate in such improvement efforts as strategic planning. The world languages provided in the district are varied including: Spanish, French, Italian, German, Latin, Russian, and Advanced Placement courses are offered in these languages. Additionally, students must complete two years (or ten credits) in world languages to graduate even though the State requirement is only one year (five credits). Also, the district has long-term learning goals for world languages which include: 1) communicating effectively in more than one language in a variety of situations and for multiple purposes, 2) demonstrating cultural awareness based on understanding of and respect for other cultures, past and present, 3) making connections with other disciplines by applying learning from language class to relevant situations in other classes, and 4) using the language to investigate, explain, and reflect on the concept of culture through comparisons of the cultures studied and their own. These goals are available on the district’s website and serve as a reference for curriculum writing and programmatic decisions. Consequently, there are many positive initiatives in world languages already in place in the district, but it is important to continue this tradition and always seek ways to improve or do better.

The district promotes achievement in world languages in different ways. For instance, there are currently alignment agreements with local colleges and universities, so
students can receive dual credit for advanced language courses taken while in high school. Furthermore, students in the world language program are able to take the New Jersey Seal of Biliteracy test. When students pass the test, they receive a certificate from the State, a commendation on their transcript, and a pin to wear at graduation. Students also may take proof of proficiency language tests via the district’s Option #2 program. When students receive a grade of “B” or higher, they may advance onto the next level of the course and receive credit towards their GPA. In addition, although the district serves students in grades nine through twelve, there exists a strong relationship with the middle schools which encourages ongoing articulation and program alignment. In fact, students in middle school, who take accelerated Spanish in both grades 7 and 8, may receive Spanish I credit at the high school upon entering as freshmen. Many of these students take Spanish 2 Honors, then, as freshmen which enables them to reach the AP Spanish course as seniors. The middle school teachers also join the high school teachers for various professional development days or consortia to promote learning, ongoing collaboration, and partnerships. Overall, the district holds academics in high regard, and there is an emphasis on providing for the needs of all learners.

**Overview of Methods**

This qualitative study employed a grounded theory approach. Twenty-seven students of Italian and Spanish from two high schools participated. A mixture of male and female students from different levels of instruction (Advanced Placement, honors, accelerated, and college preparatory) comprised the possible pool of candidates. Additionally, students represented various ages (both upper and lower classmen) as the courses were not tied to one particular grade level. The researcher interviewed 10
students, followed by administering a survey to 28 students (27 responded) and a questionnaire to 20 teachers (12 teachers responded). The study also involved the collection of material culture such as lesson plans and digital artifacts, the gathering of findings using a class observation protocol, and the engagement in analytical memo writing. First cycle coding was used to develop main codes, followed by second cycle coding to determine emerging themes.

Saldaña (2016) defines a code as a word or short phrase that symbolically assigns a summative, salient, essence-capturing, and/or evocative attribute for a portion of language-based or visual data. Thus, I employed process coding for student interviews and observations as well as simultaneous coding to discern keywords from the data throughout the investigation. I engaged in the constant-comparison method to judge the prevalence or repetition of codes. The codes were then grouped into categories to determine emerging patterns. Patterns such as similarity, difference, frequency, sequence, correspondence, and causation were all considered when analyzing the data (Hatch, 2002). Overall, theories served as a lens to conceptualize the data.

**Research Questions**

The research questions of the study relied heavily upon the students’ and teachers’ experience with and perception of the ReLANpro resource. The questions manifested in various ways including, but not limited to: student interviews, student surveys, a teacher questionnaire, material culture such as lessons and digital artifacts, class observations, and analytical memo writing. The research questions of the study included:

- What are students’ perceptions of the effectiveness of the ReLANpro digital language lab on their self-efficacy in language production?
- How do students describe their experience using the ReLANpro digital lab?,
- To what extent are students afforded language learning opportunities in speaking, writing, reading, and listening upon the use of ReLANpro as measured by artifacts?, and
- What are teachers’ perceptions of the effectiveness of the lab and recommendations for best practices in both training and implementation?

**Role of the Researcher**

The study was of an emic nature as the researcher also served a supervisor of world languages at one of the schools in the district. For that reason, the researcher included a sister school in the study to rule out insider bias. The researcher worked in the district fourteen years, but she has been an educator for a total of thirty years. She taught English language arts and social studies for 11 years, followed by serving as a supervisor of English language arts and world languages. Consequently, she has worked throughout four varied districts, some with K-12 configurations and others with grade 5-12 and 9-12 with different language offerings. Overall, she has observed and evaluated world language teachers across all grade levels K-12 and has guided teachers with writing curricula, implementing new resources to support instruction, and providing professional development opportunities to promote best practices and student achievement. As a result, she has developed a sense as to appropriate instructional objectives per grade level as well as proficiency benchmarks given varying amounts of instructional time afforded the learner.
**Researcher Assumptions**

As an educator of 30 years and supervisor of instruction, I assume that most students like and engage with digital tools. Prensky (2001) notes that students are naturally “digital natives”. Therefore, they grow up using different technologies which are very natural to them. Consequently, they are unlike older adults or “digital immigrants” who learned how to manipulate modern technologies after traditionally using such devices as typewriters or desktop computers. It is also true that students may know how to use various devices, yet they do not know the full range of possibilities of various technologies or which devices are best for certain tasks. Throughout the study initial assumptions will be either confirmed or denied as part of the ongoing investigation.

Another assumption is that many students experience anxiety learning a language and can benefit from more authentic and diverse practice opportunities. This assumption has been reinforced upon observing and evaluating K-12, both formally and informally, throughout world language classrooms in four varied school districts. Also, via teacher post-conferences, I learned that world language educators welcome new ways to assess students rather than relying on merely face-to-face methods which can be very time-consuming. Lastly, I recognize that schools and educators, in particular, experience implementation dips as they work with new programs and methodologies (Fullan, 2001). Therefore, change can oftentimes involve ambiguity and restlessness which is all part of the learning process.
Definitions of Key Terminology

To understand how the learner acquires a world language, the various language levels, pertinent language organizations and assessments, and effective instructional methods in teaching which promote proficiency, it is critical to conceptualize key terminology related thereto. Thus, specific terms should prove helpful in delineating important aspects of second language acquisition and learning (see Appendix A).

Summary

This introduction provided a background of the benefits of second language acquisition and learning, inequities throughout world language programs, ReLANpro as a possible solution to inequities, the rationale and purpose of the study, an overview of the methods, the research questions, and the researcher’s role and existing assumptions. Moreover, it explored several reasons for examining the influence of a blended learning resource on students’ self-efficacy in the world languages classroom. Finally, it laid the groundwork for delving further into the existing literature surrounding second language acquisition, student language attitudes, and blended learning to reinforce further the purpose of the study.
Chapter 2

Introduction

It is important to examine the various second language acquisition approaches employed over the decades to understand fully where educators have been and where they are headed. Therefore, the chapter will first chronicle the historical background of language learning, elaborating on both successes and failures of different techniques and reasons related thereto. Along with providing a historical review of second language acquisition approaches, the chapter will further explore Bandura’s social cognitive theory, which examines processes occurring within the learner, both mental and affective, as he or she interacts with the environment. Moreover, as the study’s focus is on students’ perspectives of their own language learning experience using a digital language lab, the chapter will also analyze the various technological tools used over the ages as well as the effects these blended learning tools have had upon students’ second language acquisition. These three focus areas, then, will constitute the primary structure of the chapter.

To supplement the focus areas, I will further explore topics directly related to language attitudes, such as students’ self-efficacy, motivation, attribution, and language anxiety. These constructs will be addressed as they all play a part in student outcomes in language learning. Additionally, I will analyze the versatility of ReLANpro as an example of a multi-modal resource which may encourage practice in a second language, differentiation of instruction, varied assessment techniques, student engagement, and risk-taking.
A Historical Look at Second Language Learning

The existing literature on second language acquisition presents various second language acquisition approaches as well as many variables that can influence learning. For example, early research first describes the audio-lingual method as an instructional practice, which was very teacher-centered. This technique is followed by computer-assisted language instruction (CALI), computer-assisted language learning (CALL), technology-enhanced language learning (TELL), and artificial intelligence (AI). Later approaches include: mobile assisted language learning (MALL), multi-modal learning, and blended learning. Additionally, there is a large body of research regarding teacher-centered environments versus learner-centered environments. Furthermore, there is a considerable amount of research on students’ language anxiety, motivation, self-efficacy, attribution, and achievement. I will use these various bodies of research to show advancement in the knowledge of second language acquisition and best practices in the field. Also, I will demonstrate how different studies point to the effectiveness of student-centered learning environments supported by blending formats and multi-modal tools.

Second language acquisition and learning reflects a certain historical evolution or cycle. Between the 1960s and 1970s, the Audio-Lingual Method (ALM), which emphasized precision of language, repetition, and correction, dominated North America (Richards & Rodgers, 2001). The specific language focus was on morphology, vocabulary, and syntax. Additionally, the mindset was steeped in behaviorism and the operant-conditioning model of linguistic behavior relying on positive reinforcement and feedback (Skinner, 1957). Brooks (1964) detailed how behaviorist theory was to be applied in the classroom, with teachers providing linguistic stimuli in the form of
dialogues and drills, reinforcing students’ correct responses and correcting their errors. He further summarized the application of behaviorist theory to language learning in his statement: “The single paramount fact about language learning is that it concerns not problem-solving, but the formation and performance of habits” (p. 49). With respect to early linguistic methods, then, the teacher prescribed the way the language would be used, and the students complied with these expectations. Consequently, an early onus was placed on the teacher to stimulate certain behaviors in the student which did not encourage independent, critical thought, empowerment in the language learning process, or production of the language via retrieval of previously learned structures.

Over time with the arrival of personal computers and programmed instruction, educators began utilizing more computer-assisted language instruction. Universities such as Illinois used computer programs (PLATO project) developed on mainframe computers (Marty, 1981). Regardless of the advancements in technology, this phase was still more teacher-focused and gradually faded in popularity. Nevertheless, teachers still did not have enough time to adequately assess oral proficiency using traditional, face-to-face methods (Larson, 2000). Despite this fact, oral proficiency still rose as the main goal of second language learning (Moeller & Theiler, 2014). Gradually, it became evident the emphasis should be placed on student-centered learning with proficiency as a central focus.

In the midst of the evolution of second language acquisition and learning, the student became the central figure of attention – not the teacher. Glasersfeld (1989) contends that the learner should be responsible and actively involved in the learning process, which is consistent with constructivism, but in opposition to behaviorism.
Students are still faced, however, with such constructs as language anxiety that may affect learning and determine whether or not they can notice feedback and produce output (Horwitz, 2001; Sheen, 2008). In the context of language learning, anxiety is viewed as the feeling of tension or apprehension (MacIntyre & Gardner, 1994) which can be caused by a specific situation or event (Ellis, 2008). While Young (1991) notes that language anxiety can take various forms, Tallon (2011) indicates it can play a significant causal role in creating individual differences in language learning (p. 75). Consequently, teachers should be aware of this barrier to learning and search for ways to make language production opportunities more varied and anxiety-free for students. Additionally, in pursuit of this goal, teachers should enable students to become more in charge of their own learning.

As ongoing understanding of second language acquisition evolves, there is a necessary shift to student-centered learning environments, and the teacher becomes more of a facilitator. In this role he or she must adapt and help the learner find his or her own understanding (Bauersfeld, 1995; Gamoran, Secada, & Marrett, 1998). Fortunately, in the early 1980s there was a desire to provide more practice opportunities for students via computer-assisted language learning (Davies & Higgins, 1985; Kern, 1995; Davies et al, 2011; Levy & Hubbard, 2005; Butler-Pascoe, 2011). Higgins and Johns (1984) produced a seminal work detailing approaches within CALL which embraced more communicative methods and new technologies. In time CALL involved such platforms as: virtual learning, concordancers, distance learning, computer-mediated communication (CMC), and digital language labs.
At this time of technological advancements in world language instruction in the late 80s and early 90s, artificial intelligence techniques were also popular to determine a learner’s response (Matthews, 1994), yet there were many who perceived this approach to be a threat to humanity (Last, 1989, p. 153). Others presented more exploratory approaches with concordance programs in language classrooms as part of data-driven learning (DDL) such as MonoConc, Concordance, and Wordsmith (Johns, 1991; Tribble & Jones, 1990). Consequently, with these new platforms, students reaped the benefits of blended learning, or a combination of traditional methods with support from enhanced, technological tools (Pegrum, 2009; Bonk & Graham, 2006). Blended learning has enabled students to increase their learning potential (Pegrum, 2009, p. 27). With this shift, students, as digital natives, are better able to take ownership of their own learning and utilize 21st century skills (Prensky, 2001).

Considering students’ skills in learning, research conducted on high school students’ achievement in second language acquisition has been primarily quantitative in nature (Tschirner & Heilenman, 1998). As such, students’ second language proficiency has been measured more numerically at the high school level and has focused on oral proficiency levels given varying years of instruction. Moreover, the majority of studies on second language acquisition have been geared towards English as a Second Language (ESL) or college level students. With respect to ESL, the studies describe how various instructional practices, learning environments, and resources may affect learners’ language acquisition.

There is limited research regarding the relationship between self-efficacy and the academic achievement of language learners (Hunt, 2003; Mills, 2004). For this reason,
the prospect of conducting a qualitative study on high school students’ self-efficacy in second language acquisition upon the implementation of a digital language lab could only contribute to the existing body of knowledge on the topic and benefit schools seeking versatile learning formats in the world language classroom to foster equity and proficiency.

**CALL, MALL, and ReLANpro**

Linguists have synthesized the research on the effectiveness of computer-assisted language instruction and learning, mobile-assisted language learning, and ReLANpro in particular. Pederson (1988) and Dunkel (1991), for instance, summarize the findings as follows: a) CALL practice is possible, preferable, and meaningful; b) the way CALL is designed to encourage language learning skills can result in more learning; c) learner differences can be documented easily and accurately through computer tally of interactive strategies; d) learner differences can affect learner strategies, learning gains, and attitudes in CALL; e) students tend to demonstrate a more positive attitude towards CALL written by their own instructor; and, f) many language teachers desire training on how to integrate CALL into the existing curriculum. In conjunction with the findings, however, Chapelle (1989) notes: a) CALL covers a broad range of activities; b) language competence is defined as a complex set of interrelated skills which is hard to test directly; and, c) student characteristics have an impact on second language acquisition (p. 7-9). Nevertheless, findings from this time period are important to consider as part of an overall synthesis of knowledge in the field.

With mobile-assisted language learning (MALL) emerging in the past few decades, students can practice the language in authentic contexts, and teachers are better
equipped to assess proficiency as it can be done digitally at school or at home. Through Tai’s study (2012) conducted with sixth grade Taiwanese students trying to solve a museum burglary using smartphones and GPS devices, researchers discovered that MALL implementations could effectively promote both learner-centered and collaborative methodologies. Leis, Tohei, and Cooke (2015) further examined how students used phones to make video recordings of skits ahead of time and practice before submitting their work to the instructor for feedback (p. 5). Hence, students are using mobile devices to communicate and record audio or video to practice, which is replacing former computer-assisted learning resources.

The ReLANpro digital language lab offers students a myriad of ways to practice reading, speaking, writing, and listening all the while benefitting from instructor feedback. Students can listen to prompts from their instructor in class or at home and then respond using the GAP feature. Student responses are bookmarked, so instructors can insert constructive feedback into a student’s digital file. Students can also replay recordings to listen to their instructor’s voice several times as well as their own. Thus, these programs are versatile and streamline the learning process for both teachers and students. The ReLANpro digital lab, in particular, can be both hardwired and wireless (Burston, 2017). As it is iCloud-based, it is a good solution for districts with space limitations. Consequently, as students interact with a second language in different ways via technology, the presumption is they become less anxious and are afforded more opportunities for practice, self-efficacy, and proficiency in second language acquisition.

There definitely have been advancements in what students are learning and how they are learning. The diagram below depicts the historical evolution of second language
acquisition and learning with the shift from teacher-centered instruction to student-centered environments with blended learning (Figure 8). Also, it shows the progression in technological tools used in second language learning. Additionally, it reveals information regarding constructs such as language anxiety and time. Moreover, it shows the experiential knowledge and assumptions on the part of the researcher. For instance, I note experience as a supervisor has led me to believe that students face language anxiety in the world language classroom, and teachers welcome more venues and opportunities for assessment. Lastly, different theories are highlighted such as second language acquisition as well as situated action, among others.

**Figure 8.** Historical Evolution of Second Language Instructional Practices. The diagram above shows the historical evolution of second language instructional practices and connections to the teacher and learner.

A conceptual framework refers to a system of concepts, assumptions, expectations, beliefs, and theories that supports and informs the research, and is a key
part of the design (Miles & Huberman, 1994; Robson, 2011). It is a structure in which several components tie together to form a broad concept. Furthermore, it relays the researcher’s own position on the problem and gives direction to the study. It also allows the researcher to show the relationships of the different constructs he or she wants to investigate. A thorough historical look at language acquisition over the years provides a necessary background to evaluate the merit of more present approaches and practices.

**Self-Efficacy and Bandura’s Social Cognitive Theory**

Self-efficacy is central to how students feel, think, motivate themselves, and behave. Since Bandura’s (1977) seminal article, more modern-day theorists such as Eccles (1983) have used self-efficacy to predict and explain a wide range of human functioning. Bandura (1986) defined self-efficacy as: “People’s judgments of their capabilities to organize and execute courses of action required to attain designated types of performances.” According to Multon, Brown, and Lent (1991) and Schunk (1991), self-efficacy beliefs are often better predictors of success than prior accomplishments, skills, and knowledge. In fact, many note that learners with positive self-beliefs seem to have better control and awareness of effective learning strategies (Goh, 1999; Victori, 1999; Vogely, 1995). Furthermore, the stronger the perceived self-efficacy, the greater challenges students set for themselves (Mills, Pajares, & Herron, 2006). Therefore, students’ self-efficacy determines how they visualize success and the extent they will take risks in the world language classroom.

Many scholars further believe self-efficacy to be a critical component to the study of academic achievement, motivation, and learning, and the topic has been explored for close to forty years (Pajares, 1996; Schunk, 1991). In educational research self-efficacy is
often measured using self-report surveys that ask participants to rate the strength of their belief in their ability to execute activities (Bandura, 2006). The scales pose many questions of an affective nature that enable the learner to reflect and self-assess. Hence, using self-efficacy scales, educators are able to determine students’ perceptions of their learning experiences and potential.

Self-efficacy is actually a component of Bandura’s social cognitive theory (SCT) which postulates that people acquire information to evaluate efficacy beliefs from four sources: a) enactive mastery experiences, b) observations of others, c) forms of persuasion, and d) physiological and affective states from which people judge their capabilities. Enactive mastery experiences have proven to be the most influential in providing information as they are very direct and authentic (Bandura, 1997). With these experiences the learner’s self-efficacy belief determines how he or she approaches a specific goal. The interconnectedness between the components is what Bandura refers to as reciprocal causation. These sources of information, then, assist the learner in the overall cognitive processes needed for effective second language acquisition. Thus, there exists a multitude of reasons why self-efficacy should be figured central to this qualitative investigation.

Other Constructs Influencing Language Learning

Self-regulation. It is important to differentiate self-efficacy from other language attitudes. For instance, educators have examined the difference between self-efficacy and self-regulation in the world language classroom. “Self-regulation is not a mental ability or an academic performance skill; rather it is the self-directive process by which learners transform their mental abilities into academic skills” (Zimmerman, 1990, p. 65).
Zimmerman also describes the self-regulated learning process with three stages: a) forethought, learners preparing work before performance on their studying; b) volitional control, which is also called "performance control”, involving learners’ attention and willpower, and; c) self-reflection, when learners review their performance toward final goals. Zimmerman and colleagues (2011) further specify three important characteristics of self-regulated learning: a) self-observation (monitoring one's activities) which is considered the most important of these processes, b) self-judgment (self-evaluation of one's performance), and c) self-reactions (reactions to performance outcomes). To simplify, self-regulation is how one manages learning and is a helpful skill to students along their path to proficiency.

**Metacognition.** Metacognition refers to reflection or thinking about what one knows (Darling-Hammond, Austin, Cheung, & Martin, 2003). It plays an important role in oral communication of information, oral persuasion, oral comprehension, reading comprehension, writing, language acquisition, attention, memory, problem-solving, social cognition, and various types of social control and self-instruction (Flavell, 1979). Consequently, metacognition reflects a higher level of knowing as learners are cognizant of what they do and do not know.

**Motivation.** Although Atkinson developed an early theory of motivation in the 1950s and 1960s called the expectancy-value theory, Eccles (1983) adapted it for education. According to this theory, students’ achievement and achievement-related choices are largely determined by two factors: a) expectancies for success, and b) subjective task values. Expectancies refer to how confident an individual is in his or her
ability to succeed in a task as opposed to task values which refer to how important, useful, or enjoyable the individual perceives the task.

Motivation is typically referred to as a choice of a particular action combined with the persistence and effort expended in it (Dörnyei, 2001). With respect to this language attitude, there are different theories of motivation that foreign language educators refer to, namely: a) Gardner’s (1985) socio-educational model with its distinction between instrumental and integrative orientation; b) self-determination theory (Deci, 1992) which differentiates between intrinsic and extrinsic motivation, and; c) goal theories of motivation (Houle, 1981) which elaborates upon two types of goals (mastery and performance) as well as three types of learners (goal, activity-oriented, and learning-oriented). Although different theories exist, the common denominator is that motivation plays a marked role in student achievement. In fact, motivation has been reported to be the most critical factor for success within computer-assisted language learning environments (Brandl, 2002; Desmaris, 2002; Doherty, 2002; Gilbert, 2001; Murday & Ushida, 2002; Warschauer, 1996a, 1996b). Lastly, Winne and Marx (1989) note that it is both a condition for and consequence of effective instruction.

One’s motivation for learning is sustained as he or she is challenged within close proximity to, yet slightly above, his or her zone of proximal development (Vygotsky, 1978). This premise is in line with (Prawat & Floden, 1994) who asserted that an individual’s feelings of competence and belief in his potential to solve problems is derived from first-hand experience and is more powerful than any external acknowledgement or motivation. With principles such as scaffolding, co-constructed knowledge, dialogue, and cultural tools, students are able to acquire new knowledge and
understandings. Thus, the central emphasis will be on the student and how he or she assimilates new information, or reframes a mental representation of the external world to fit a new experience. Therefore, if educators can make a task such as speaking less daunting by providing more practice opportunities via a digital language lab, then investment in the program will be worthwhile as students are more likely to envision tasks achievable and desirable.

**Growth mindset.** In conjunction with self-efficacy and motivation, a student’s mindset can also be a key contributor to his or her success in second language acquisition and learning (Dweck, 2006). With a fixed mindset, students believe their abilities are innate; they are either “intelligent” or not – they either understand or “can do” world language class or cannot. With a growth mindset, however, students believe their learning can develop over time with hard work. These students tend to be more resilient as their mindset allows for both success and failure. Failure is a minor setback which provides the student with an opportunity for reflection and self-improvement. And so, failure is merely a non-success moment which is a short stoppage along a journey to proficiency.

**Attribution.** As students learn, they assign value to what they are learning. Attribution theory was a concept developed by Fritz Heider and Bernard Weiner in modern psychology which emphasizes that learners are strongly motivated by the pleasant outcome of being able to feel good about themselves (Vockell, 2008). According to this theory, there are four factors students use to determine success: a) ability (natural aptitude or acquired proficiency), b) effort (a serious attempt to do something or energy used to do something), c) task difficulty (the quality of something that makes it hard to do or the ease of which something can be done, and d) luck (the things that happen due to
chance). Overall, the more students exercise a control over their own learning that includes both successes and failures, the more they are motivated to put forth effort in future learning.

**Language anxiety.** The construct, which is considered part of a learner’s affective filter, can be a barrier to comprehension and cause negative outcomes. Since the 70s the primary components of student language anxiety appeared in such surveys as the Foreign Language Attitude Scale (FLAS) (Bartley, 1970), the Attitude/Motivation Test Battery (AMTB) (Gardner, 1985), the Foreign Language Classroom Anxiety Scale (FLCAS) (Horwitz et al, 1986), and the Beliefs and Attitudes Language Learning Inventory (BALLI) (Horwitz, 1988). Additionally, Spolsky (1989) and Skehan (1989) further consulted these instruments when seeking to define anxiety as well as other learner attitudes, perceptions, and beliefs. This construct will be considered, then, along with self-efficacy in the investigation.

**Technological Approaches to Language Learning**

**Blended learning.** In today’s classrooms, teachers use blended learning with programs and tools such as: Quizlet, Duolingo, Kahoot, Edmundo, Moodle, Peardeck, Gimkit, and voice memo with smartphones. Students, then, are definitely accustomed to using phones and other technological tools to support language learning. Blended learning, then, appears to be one way to encourage student engagement, practice, and perhaps self-efficacy. It occurs when face-to-face instruction is augmented by technology. According to Levy (1997), although hardware and software may shape what is and is not possible with a computer-assisted language learning project, the teacher may contribute significantly to the conceptualization of CALL and determine the extent a
program is actually utilized. Thus, the end-product may be different from the one originally conceived (p. 9). Consequently, the end-product might be better or worse than the original conception.

**Implementation considerations.** Before implementing blended learning, administrators need to build consensus with teachers as to why a blended learning approach is beneficial to them and their students (Brooke, 2015). If consensus is not reached, the perception will be that another initiative is being implemented without teacher input. Additionally, administrators must inventory their school or district’s current infrastructure to determine if there is a foundation in place for blended learning success. Depending upon the circumstances, funds may need to reallocated, networks updated, technology supports determined, and schedules changed to allow for ongoing collaboration. Furthermore, when determining the best blended tool, stakeholders should consider four key factors: 1) the tool should be one that can adapt to each student’s abilities, 2) the tool must be able to capture student data, 3) the tool should recommend next steps for the teacher, and 4) the tool should provide resources for teacher-led instruction. Consequently, if consensus is not reached and the four factors cannot be met, stakeholders should consider other solutions.

**Teachers’ perceptions.** Teachers have said that blending learning solutions may help to individualize instruction, engage students, provide immediate feedback, foster organization, encourage real-world relevance, and inspire student-centered classrooms which enrich the learning environment (Sorbie, 2015, p. 53). However, these same teachers also have shared concerns regarding implementing technology with building wifi issues and the lack of professional development time (Sorbie, 2015). As a result of the
struggles with implementation, the schools opted to form professional learning communities to provide teachers a venue to learn the best ways to integrate the technology into instruction and solve problems together. Other studies conducted by Romeo (2017) and Schmid (2012) echoed this need of teachers to make blending solutions their own through collaborating with one another and incorporating technology into specific instructional units of the curriculum.

**Blended learning in action.** Different formats that support using technological tools in the classroom to support the learning process are those of Hutchins (1995a), Suchman (2006), and Stepp-Greany (2002). Hutchins (1995a) posits that knowledge is not confined to an individual; rather, it is distributed across objects, individuals, artifacts, and tools in the environment. When language learning opportunities are distributed across various objects, people, and tools, there is more of a likelihood of comprehension as students’ ways of practicing and knowing are expanded. Therefore, the digital language lab may serve as a tool which allows learning via different artifacts and individuals (teacher and peers) to promote language acquisition to a greater degree. Similarly, Suchman (2006) asserts with situated action theory human action is constantly constructed and reconstructed from dynamic interactions with the material and social worlds. Additionally, Stepp-Greany (2002) supports a whole language approach in which language is seen through an interactional or social perspective whereby there is an emphasis on authenticity to help students internalize language concepts. Consequently, these arrangements support the prospect of providing an integrated or blended learning environment with mobile-assisted language learning for students of world languages.
Technology Providing Pathways to Learning

According to the American Council on the Teaching of Foreign Languages (ACTFL, 2017), technology can and should be used by language educators to enhance language instruction, practice, and assessment, as articulated in the world-readiness standards for learning languages. Through the purposeful use of technology, students: a) read, listen to, and view authentic, engaging, and timely materials from the target culture; b) practice interpersonal skills as they interact via video, audio, or text in real-time with other speakers of the target language; c) collaborate on presentational tasks with their peers or teacher, anytime, anywhere; d) work at their own pace as they access online content and/or utilize computer adaptive programs managed by their teacher; e) practice discrete skills with engaging online games and applications, and; f) benefit from differentiated instruction where multiple applications can be used to assess students, assign varied tasks, track data, give real-time feedback, and manage classrooms and lessons. Thus, the use of technology is not a goal in and of itself. Rather, it supports learners as they use the target language in culturally appropriate ways to accomplish authentic tasks. Assessing students’ perspectives of a technological tool such as a digital lab is important as their perspective is their reality. If they envision it as a helpful tool, they might be more engaged in the process and willing to take more risks with the target language.

Multi-modality. A digital lab such as ReLANpro provides students multi-modal experiences which can maximize learning opportunities for different learners. Gardner (2004) contended “anything that is worth teaching can be presented in many different
ways - these multiple ways can make use of our multiple intelligences.” Interestingly, Gala (1993) and Heining-Boyton (1994) maintain that teaching through more than one modality can enable at-risk and learning disabled students to experience success as language learners. In fact, the instructional practices recommended for at-risk students are the same ones that research is advocating for all students. Genessee (1992), for instance, found that at-risk learners in French immersion programs scored at the same level as higher-ability students on listening comprehension and speaking tests. Moreover, grouping and tracking are a generally considered ineffective means for addressing individual differences (Goodlad & Oakes, 1988). Consequently, learning a world language should not be reserved for students who are high achievers as learner aptitudes vary and do not always correlate directly to abilities in other content areas.

These new ways of learning, then, demonstrate a definite shift in the focus of instruction and what students need to know and be able to do. According to Kumagai, Lopez-Sanchez, and Wu (2016), “language learning can no longer solely be concerned with language per se…world language education needs to move beyond current communicative and language-focused approaches, and into those that prepare students to be effective producers and consumers of multi-modal texts” (p. xiii).

An important related term to multimodality is multiliteracy, which is the comprehension of different modes in communication – not only to read text, but also to read other modes such as sound and image. Whether and how a message is understood is accredited to multiliteracy. Hull and Nelson (2005) in their seminal article on multimodality call for more attention to be paid to the aesthetics of multi-modal composition. Since their seminal work, the field of literacy study has shifted to the changing nature of
literacies, the new forms of participation, the environments this participation is taking place, and multi-modality as a lens for students’ digital compositions. Consequently, literacy and multi-modality are being interpreted in much broader, more modern ways.

Kress (2010) asserts that all communication, literacy, and composing practices are and always have been multimodal. Multimodality is a theory of communication and social semiotics. It describes communication practices in terms of textual, aural, linguistic, spatial and visual resources, or modes, used to compose messages. In terms of media, it is the use of several modes (media) to create a single artifact. The collection of these modes contributes to how multimodality affects different rhetorical situations, or opportunities for increasing an audience’s reception of an idea or concept. Using different components of a digital lab, an educator may have a better chance of appealing to a larger group, thereby prompting an audience to be more receptive to language learning.

Kress defines mode in two ways. In the first, a mode is a socially and culturally shaped resource for meaning making. Image, writing, layout, speech, moving images are examples of different modes (p. 79). In the second, semiotic modes are shaped by both the intrinsic characteristics and potentialities of the medium and by the requirements, histories and values of societies and their cultures (Kress & van Leeuwen, 1996, p. 35). Interestingly, Bateman (2008) further posits that text is just one strand in a complex presentational form that seamlessly incorporates visual aspect ‘around,’ and even instead of the text itself. Therefore, every mode has a different modal resource, which is historically and culturally situated and which breaks down into its parts, because each has distinct potentials and limitations for meaning (Kress, 2010, p. 1).

**Visual literacy.** Using visual prompts, world language educators can employ a
modality which can assist students in second language acquisition and learning. Bristol and Drake (1994) contend that visual literacy is the ability to interact, negotiate, and make meaning from information presented in the form of an image. Visual literacy is the repeated use of visual elements in a lesson to foster student engagement and increase proficiency. Using visual prompts, students are prompted to use more independent, immersive, and spontaneous language upon receiving an image.

In an information age with students accessing digital images on a daily basis, many interpret visual literacy as the foundation for verbal literacy. Debes (as cited in Fransecky & Debes, 1972) first coined visual literacy with his definition:

A group of vision-competencies a human being can develop by seeing and at the same time having and integrating other sensory experiences. The development of these competencies is fundamental to normal human learning. When developed, they enable a visually literate person to discriminate and interpret the visible actions, objects, symbols, natural or man-made, that he encounters in his environment. Through the creative use of these competencies, he is able to communicate with others. Through the appreciative use of these competencies, he is able to comprehend and enjoy the masterworks of visual communication. (p. 7)

Consequently, visual and verbal skills are interconnected such that one prompts and encourages the use of the other.

Debes (as cited in Fransecky & Debes, 1972) further explains how visual and verbal language operate. He posits that verbal and visual thought processes precede speech and writing. He further elaborates that language has a deep structure and a surface
structure. A good visual statement, then, begins with an underlying idea (deep structure) from which the communicator develops a surface structure of visual presentation. With a digital language lab, students can view photos and then practice writing corresponding text in the target language. They can also listen to their teacher’s prompt before recording a response or communicating with peers via headsets. In this way they have more of an opportunity to build their confidence and skills in the language.

According to Fransecky and Debes (1972), the structure of visual language is a relationship among visual thinking, reading, and writing which is the structure of discourse. The visual skills are used to develop a skill base to help learners generate visual language statements, photographs, and films. It is paramount to make this distinction with visual learning without completely fragmenting the two. In fact, structure and skills of visual literacy must be constantly clarified. Therefore, there is a distinct delineation between structure and skills in visual literacy.

Others have echoed the definition described by Debes (1972). Burmark (2002) defines visual literacy as the ability to see, understand, read and interpret, communicate using visual tools, and to think, create and communicate visually. The visually literate person is the one who sees the meaning behind images, examines images carefully and critically, and uses and creates visually rich material. It is no secret that visual images can evoke, stimulate, inspire, conjure, remind, propel, and provoke, yet it is the receiver of the visual image, or the student, who must make meaning.

More modern-day educators tout the value of visual literacy. This sentiment is echoed in an Edutopia blog by Finley (2017):

The Common Core requires students to demonstrate the ability to
interpret, recognize, appreciate and understand information presented through visible actions, objects and symbols, natural or man-made.

Consequently, literacy has surpassed understanding the written text and has moved onto visual aspects which has further tapped students’ critical thinking skills.

**Differentiated instruction.** The ReLANpro lab allows teachers a venue to differentiate in the classroom. Through differentiating instruction and meeting students “where they are” in language study, an instructor increases his or her chances of positively affecting students’ attitudes about language learning and self-efficacy. By varying modes of instruction and assessment, he or she is better able to differentiate in the classroom and meet the needs of individual learners. In its most basic definition, differentiated instruction is a research-based model of classroom practice, which supports teachers in developing curriculum and instruction that maximizes the capacity of a diverse group of learners. Hence, differentiation involves responding to individual learning needs that exist among students in any classroom (Shalaway, 2005; Tomlinson, 1999). It is instruction which occurs when students’ preferred ways of learning are taken into consideration rather than relying solely on teachers’ judgments. Tomlinson (2015) posits that differentiation includes such components as: a) interrelated roles of the classroom environment; b) curriculum, assessment, and instruction; c) classroom management in addressing the various readiness levels; d) student interests, and; e) approaches to learning which are evident in contemporary classrooms. The goal of the model, then, is to provide access and equity to all learners as well as to increase learner motivation and achievement. Providing multi-modal tools in a world language classroom,
teachers may support differentiated instructional strategies and expand the possible ways students learn the language.

**Assessment.** Using a digital language lab such as ReLANpro to differentiate instruction and meet the needs of all learners, world language educators may also expand opportunities for assessment and feedback. In fact, they can use the resource to provide formative assessments which can inform instruction and serve as assessment “for” learning. According to Duncan (2015), assessment should mirror instruction, connect to learners, and provide data to advise students on progress towards targets. Duncan posits that assessment design should actually be the second step in planning and follow the identification of learning targets, allowing students ways to show how they can communicate meaningfully in daily situations. Furthermore, assessment should connect to real-life tasks which command the learner’s best efforts. Additionally, assessment should involve rubrics that are understood and valued by the learner as well as provide important information educators can use to improve teaching and learning. Thus, a digital language lab such as ReLANpro would provide a venue for teachers to offer students ongoing feedback, as well as a myriad of different types of tasks to challenge the language student.

**The Importance of Feedback**

An important element of the study will be to decipher if the use of the digital lab offers students important feedback which contributes to their language learning. Although researchers have debated what feedback really is, many concur that assessment coupled with diversified opportunities that provide feedback enhances performance and achievement (Hattie, 2008). Wiggins (2012) further notes that feedback is different from
both evaluation and advice. Rather, true feedback is: a) goal-oriented, b) tangible and transparent, c) actionable, d) user-friendly, e) timely, f) ongoing, and g) consistent. Consequently, one outcome of this study will reveal the extent the language lab offers students meaningful feedback in their proficiency journey.

**Second Language Acquisition Theory**

The digital language lab which supports a blended learning structure is in harmony with second language acquisition principles. Stephen Krashen’s (1988) second language acquisition (SLA) theory, in particular, is the one most recognized and accepted by linguists. It consists of five main hypotheses: a) the acquisition-learning hypothesis, b) the monitor hypothesis, c) the input hypothesis, d) the natural order hypothesis, and e) the affective filter hypothesis. According to the theory, there are two independent systems of second language performance: the acquired system and the learned system.

The acquired system or acquisition is the product of a subconscious process very similar to the process children undergo when they acquire their first language. It requires meaningful interaction in the target language - natural communication - in which speakers are concentrated not in the form of their utterances, but in the communicative act itself. The learned system or learning is the product of formal instruction, and it comprises a conscious process which results in conscious knowledge about the language, for example knowledge of grammar rules. In this model learning is less important than acquisition.

The monitor hypothesis explains the relationship between acquisition and learning and defines the influence of the latter on the former. The monitoring function is the practical result of the learned grammar. The acquisition system is the utterance initiator,
while the learning system performs the role of the monitor or the editor. The monitor acts in a planning, editing and correcting function when three specific conditions are met: that is, the second language learner has sufficient time at his/her disposal, he/she focuses on form or thinks about correctness, and he/she knows the rule.

It appears that the role of conscious learning is somewhat limited in second language performance. The role of the monitor is - or should be - minor, being used only to correct deviations from normal speech and to give speech a more polished appearance. Krashen (1988) also suggests there is individual variation among language learners with regard to monitor use. He distinguishes those learners that use the monitor all the time (over-users); those learners who have not learned or who prefer not to use their conscious knowledge (under-users); and those learners that use the monitor appropriately (optimal users). An evaluation of the person's psychological profile can help to determine to what group they belong. Usually extroverts are under-users, while introverts and perfectionists are over-users. Lack of self-confidence is frequently related to the over-use of the monitor.

The input hypothesis is Krashen's (1988) attempt to explain how the learner acquires a second language – how second language acquisition takes place. The input hypothesis is only concerned with acquisition, not learning. According to this hypothesis, the learner improves and progresses when he/she receives second language input that is one step beyond his/her current stage of linguistic competence. For example, if a learner is at a stage 'i', then acquisition takes place when he/she is exposed to comprehensible input that belongs to level 'i + 1'. Comprehensible input can then be defined as the target language that the learner would not be able to produce but can still understand. It goes
beyond the choice of words and involves presentation of context, explanation, rewording of unclear parts, and the use of visual cues and meaning negotiation. The meaning successfully conveyed constitutes the learning experience. Hence, using a lab to augment instruction and provide students with ways to build comprehensible input is a desirable goal.

Another way teachers have tried to build comprehensible input is through a technique called Teaching Proficiency through Reading and Storytelling (TPRS). This is an approach to teaching language that focuses on the systematic instruction of vocabulary in a highly comprehensible, personalized, and contextualized manner. It involves using gestures and other visuals to make a story interesting and memorable. As students become more engaged, they learn grammar and vocabulary through the events of the story and their interaction with the teacher. In this manner students may have increased opportunity for input.

The natural order hypothesis is based on research findings (Dulay & Burt, 1974; Fathman, 1975; Makino, 1980 as cited in Krashen, 1987) that suggest that the acquisition of grammatical structures follows a natural order which is predictable. For a given language, some grammatical structures tend to be acquired early while others late. This order seemed to be independent of age, language background, and conditions of exposure. Although the agreement between individual acquirers was not always 100% in the studies, there were statistically significant similarities that reinforced the existence of a natural order of language acquisition. Krashen (1987), however, stipulates that the implication of the natural order hypothesis is not that a language program syllabus should
be based on the order found in the studies. In fact, he rejects grammatical sequencing when the goal is language acquisition.

Finally, the fifth hypothesis, the affective filter hypothesis, embodies Krashen's (1988) view that a number of affective variables play a facilitative, but non-causal, role in second language acquisition. These variables include: motivation, self-confidence, and anxiety. Krashen (1988) claims that learners with high motivation, self-confidence, a good self-image, and a low level of language anxiety are better equipped for success in second language acquisition. Low motivation, low self-esteem, and debilitating anxiety can combine to raise the affective filter and form a mental block that prevents comprehensible input from being used for acquisition. In other words, when the filter is up, it impedes language acquisition. On the other hand, positive affect is necessary, but not sufficient on its own, for acquisition to take place. SLA theory, then, emphasizes the importance of linguistic input for successful language acquisition.

**Focus on Communication – The Ultimate Goal**

Educators of world languages, seeking to promote a communicative approach, should emphasize specific activities and targeted proficiency goals in the classroom. According to Gebel (2011), teachers should provide: a) activities that require students to go beyond their traditional role as responder to the teacher’s questions, b) opportunities for students to use the language in meaningful interaction with others and to negotiate meaning in authentic contexts in interpersonal communication, c) opportunities for students to engage in self-expression in interpersonal and presentational communication, d) opportunities for students to hear and read a great deal of comprehensible and authentic language in interpersonal and interpretive communication, e) opportunities for
students to engage in real-life tasks, and f) a non-threatening environment in which students’ affective filter is lowered. Therefore, communication is key to world language learning, and teachers can structure experiences for students in the classroom in a myriad of creative ways to encourage students’ language production.

To provide a common understanding, it is important to define world language as well as describe the second language acquisition process. According to ACTFL (2012), a world language is a form of communication, essential to the culture of a community, with a system of sounds, letters, symbols, and/or signs recognized and utilized by humans. Moreover, ACTFL reinforces the premise that a world language fulfills all of the following criteria: a) a form of human communication used to interact and negotiate meaning with other people, to understand and analyze oral, written, or signed texts, and to create culturally-appropriate oral, written, or signed products and presentations for a specific audience and task; b) a form of human communication that allows the user to investigate, explain, and reflect on the relationship between the products, practices, and perspectives of a particular culture through the language; c) a form of human communication that allows people to exchange information about past, present, and future shared experiences, make arguments, empathize with other people, and creatively express themselves orally, visually, or in writing on a variety of topics, d) a means of human communication through which people can share stories relevant to the culture and community, whether ancient or modern, and; e) a vehicle of human communication through which people may be immersed in a specific language community, whether ancient or modern. Consequently, learning a world language is a perfect way for students to expand their worldview and explore new cultural understandings.
Students learning a second language move through five predictable stages: preproduction, early production, speech emergence, intermediate fluency, and advanced fluency (Krashen & Terrell, 1983). In the preproduction stage, students are just embarking on their language acquisition journey. At this stage, students have minimal comprehension, do not verbalize, nod “yes” and “no”, and draw and point. In a child’s native tongue, this timeframe equates to zero to six months of life. In the early production stage (six months to one year), the student still has limited comprehension, produces one to two-word responses, uses key words and familiar phrases, and uses present-tense verbs.

There are more marked differences with increased exposure to the language. In the speech emergence stage (1-3 years), the student has good comprehension, can produce simple sentences, makes grammar and punctuation errors, and misunderstands jokes. As the student becomes more proficient, the teacher increases the difficulty of interpretive, interpersonal, and presentational tasks. Interpretive tasks primarily involve such skills as reading, listening, and viewing. Interpersonal tasks, however, involve more speaking skills with peers and tend to be spontaneous in nature. Presentational tasks require students to speak for longer durations of time on assigned prompts and are typically assessed using a rubric. Nevertheless, educators should seek a balance of the three modes to promote an effective learning environment. It should be noted, however, as communication is the primary goal of world language learning, interpersonal tasks should take priority and be emphasized daily. The ACTFL (2012) chart below shows characteristics of the different modes of learning (see Table 2).
Continuing with the intermediate fluency stage (3-5 years), the student has excellent comprehension and makes few grammatical errors. Lastly, with advanced fluency (5-7 years), the student has a near-native level of speech. These steps indicate how proficiency builds over time via different learning experiences.

Table 2

*ACTFL Performance Descriptors for Language Learners*

<table>
<thead>
<tr>
<th></th>
<th>Interpersonal</th>
<th>Interpretive</th>
<th>Presentational</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active negotiation</td>
<td>• Active negotiation of meaning among individuals</td>
<td>• Interpretation of what the author, speaker, or producer wants the receiver of the message to understand</td>
<td>• Creation of messages</td>
</tr>
<tr>
<td>of meaning among</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>individuals</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Participants observe</td>
<td>• Participants observe and monitor one another to see how their meanings and intentions are being communicated</td>
<td>• One-way communication with no recourse to the active negotiation of meaning with the writer, speaker, or producer</td>
<td>• One-way communication intended to facilitate interpretation by members of the other culture where no direct opportunity for the active negotiation of meaning between members of the two cultures exists</td>
</tr>
<tr>
<td>monitor one another</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Interpersonal</td>
<td>Interpretive</td>
<td>Presentational</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Adjustments and</td>
<td>• Adjustments and clarifications are made accordingly</td>
<td>• Interpretation differs from comprehension and translation in that interpretation implies the ability to read (or listen or view) “between the lines,” including understanding from within the cultural mindset or perspective</td>
<td>• To ensure the intended audience is successful in its interpretation, the “presenter” needs knowledge of the audience’s language and culture</td>
</tr>
<tr>
<td>clarifications</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Speaking and listening (conversation); reading and writing (text messages or via social media)</td>
<td>• Reading (websites, stories, articles), listening (speeches, messages, songs), or viewing (video clips) of authentic materials</td>
<td>• Writing (messages, articles, reports), speaking (telling a story, giving a speech, describing a poster), or visually representing (video or PowerPoint)</td>
</tr>
</tbody>
</table>

*Note.* Adapted from “The Modes of Learning: ACTFL Performance Descriptors for Language Learners.” Copyright 2012 by the American Council on the Teaching of Foreign Languages.

It is important to distinguish the differences between performance and proficiency in the world languages classroom as the terms apply to students and teachers. Teachers perform well when they can gauge student proficiency levels accurately and provide learners with engaging, authentic practice opportunities to promote language acquisition. With students, performance is the ability to use language that has been learned and practiced in an instructional setting. Students, performing in a familiar context, are able
to demonstrate their knowledge of particular components of the curriculum. Proficiency, on the other hand, refers to students’ ability to produce culturally-appropriate language in a spontaneous manner. When students produce language proficiently in a non-rehearsed way, they can be understood by a native speaker, yet their language is not error-free. Proficiency, then, describes what the language learner can do regardless of when, where, or how the language was acquired. Hence, performance and proficiency are two distinct entities for each group, yet it is the teacher’s overall role to provide learners authentic practice opportunities which contribute to students’ proficiency and success with language learning.

Teachers can reflect upon how they maximize opportunities for proficiency in the classroom in several ways. First, a teacher can complete a self-evaluation from the Teacher Effectiveness for Language Learning Framework (TELL). This evaluation establishes those characteristics and behaviors that a model teacher exhibits. The framework consists of seven domains designed to address a teacher’s need to prepare for student learning, advance student learning, and support student learning. This instrument, then, poses several questions to the teacher about his or her planning, one of which deals with helping students set proficiency targets and planning with proficiency in mind.

A second way is for teachers to require students to set proficiency goals in the target language and have them self-evaluate their pathway towards proficiency using the “Can Do” statements before and after units of study. This type of self-evaluation prompts students to think in a metacognitive manner by asking them to rate their confidence or ability with various skills and language concepts at the onset of a unit and then later at the end of a unit. In this way the statements prompt them to think about what they know or
their ways of knowing. A third way to advance proficiency involves incorporating specific strategies into instruction. For example, teachers can incorporate “think alouds” in lessons. With “think alouds” teachers model and articulate their thought processes and explain the steps in solving a problem. Stepping students through the logic of a world language problem or communicative strategy, teachers can encourage students to think further in a metacognitive manner. Teachers can also adjust their rate and amount of speech, vary their sophistication of speech (pare down speech for novice learners and add synonyms for advanced learners), and provide diverse models of language production via podcasts, speeches, songs, and videos. In this way the teacher can expose students to different language registers. Additionally, teachers can repeat questions two to three times to enable learners extra process time and paraphrase as a model for students to experience circumlocution.

Circumlocution is the act of describing many features of an object, event, or action without saying the exact word for the object, event, or action. According to Gass and colleagues (2002), it is a good way to keep a conversation going while a student mentally searches in his or her head for the right words. Furthermore, teachers can also prompt students’ proficiency by requiring more elaboration in responses. For example, they can prompt by saying: a) Tell me more, b) What do you mean by that?, and c) Can anyone add to that? They can also provide sentence starters and activities which require process writing. Using various strategies, then, in conjunction with digital tools, a teacher can assist the learner in advancing his or her proficiency in the target language.
Summary

Throughout the chapter I provided a historical overview of research on second language acquisition instructional practices as well as more current day to depict a rationale for implementing blended learning opportunities throughout world language classrooms. Additionally, I discussed social cognitive learning theory which addresses mental processes occurring within learner as he or she interacts with the environment and technological tools utilized in language learning environments. Thus, I explored how educators may use multi-modal approaches and technology such as the ReLANpro digital language lab to assess, differentiate instruction, create student-centered environments, and facilitate students’ capacity for learning a world language.

With respect to student growth in learning, I have explored existing research on student self-efficacy and related constructs such as language anxiety, motivation, attribution, and various mindsets. In this manner I have demonstrated how these factors might interplay with students’ outcomes in second language acquisition. The overall review of the literature supports the premise of using qualitative inquiry to determine students’ self-efficacy upon the implementation of a digital language lab resource throughout world language classrooms. The study will best be conducted using grounded theory methods to provide rich detail and personal accounts from participants in the field. The data, then, will indicate if students consider the resource helpful to their learning and if it positively or negatively influences their self-efficacy and growth as language learners. Examining the aforementioned topics, I further laid the groundwork and purpose of the study.
The literature, then, presents the various ways infusing technology into world language instruction may enhance the classroom environment and encourage student-centered learning. This journey into the past and then to more current day shapes an evaluation of the benefits of computer-assisted language instruction and blended learning in promoting second language acquisition and self-efficacy in the learner. It also provides an impetus for the study.
Chapter 3

Introduction

The study provided pertinent information regarding the ReLANpro digital language lab program throughout two world language departments in one fairly rural regional high school district in Northeastern United States. The schools are located in an area with a county population in 2018 of approximately 400,000 (suburbanstats.org). Additionally, the majority of families are affluent. The focus was steeped in students’ perceptions of the program and language attitudes towards their own second language acquisition experience. In addition, teachers’ perceptions of program and best practices for training and implementation was also a goal of the inquiry. The actual evaluation occurred after the implementation phase of the program.

Rationale for Research Approach

The study was conducted using qualitative inquiry and grounded theory. Locke (2001, p. 30) embraces grounded theory while situating it within a qualitative paradigm requiring the researcher to commit to a theoretical perspective to orient the study. Furthermore, Charmaz (2000) asserts that grounded theory can espouse a constructivist approach whereby the discovered reality arises from an interactive process in which the researcher and subjects confer meaning upon it (p. 523-524). Madill and colleagues (2000) further echo Charmaz’s constructivist approach to grounded theory which is more current than both Glaser (1992) and Strauss and Corbin (1990).

Research Questions

The research questions of the study include:
- What are students’ perceptions of the effectiveness of the ReLANpro digital language lab on their self-efficacy in language production?,

- How do students describe their experience using the ReLANpro digital lab?,

- To what extent are students afforded language learning opportunities in speaking, writing, reading, and listening upon the use of ReLANpro as measured by artifacts?, and

- What are teachers’ perceptions of the effectiveness of the lab and recommendations for best practices in both training and implementation?

Providing questions regarding students’ and teachers’ thoughts and feelings about the experience revealed significant perspectives.

**Research Design**

The timeline for the study was as follows: a) summer 2018 – benchmark 2/dissertation proposal to committee, b) fall 2018 Institutional Review Board (IRB) approval of study, c) data collection late fall 2018 and early winter 2019, d) debrief with committee regarding preliminary data and coding, e) resume data collection winter of 2019, f) combine codes into categories, and g) complete dissertation process and defend dissertation summer 2019.

**Research Setting and Context**

The site of the research was two grade nine to twelve high schools which are part of one regional high school district located in a fairly rural area in Northeastern United States. The first school (school A) has an enrollment of approximately 1,500 students. A sister school, with an enrollment of 1,900 students, comprised the second site of the
research (school B). Both schools are highly academic in many respects, yet (school B) has a student population which is more diverse than (school A). Additionally, (school B) had more one more year of experience using digital language labs than (school A). Both schools offer the same world language courses, yet the sending schools are different.

**Research Sample and Data Sources**

With respect to possible participants, I approached the classes of the five Italian and Spanish teachers I initially observed. Therefore, the total possible student participants equaled 125. The total number of participants resulted in 27 students of Italian and Spanish. These two languages were chosen as the majority of students who take foreign language in the district are enrolled in these language courses. Additionally, there existed more levels of instruction and offerings within these two languages. Some of the students have Individualized Education Plans (IEPs) and learning differences with audio processing. Twelve teachers from both schools participated in the study from a possible pool of twenty participants. The study also included 10 student interviewees selected from the 27. Thus, the total number of student and teacher participants was 39. The research was collected in the late fall of 2018 and early winter of 2019. Throughout the course of the school year, the study depicted students’ reactions to the digital language lab and language learning in the two different languages across instructional levels. Through interviews and class observations, I gauged students’ perspectives of the lab by further analyzing speaking, reading, listening, and subtitling assignments.

**Subject Recruitment**

Prior to collecting data, I had written permission from district administration to approach students in Italian and Spanish classes as well as teachers in both schools.
Approaching students, I explained the intent of the study, the benefits and minimal risks, and protocols for confidentiality. During this meeting I further explained that the decision to participate would have no effect on class grades. At this time, I distributed consent forms and asked that they return the forms with their signatures if they were willing to participate. Students who did not wish to participate returned their forms unsigned at that time by handing them in without drawing undue attention to themselves. These students were excluded from the study. No family members were involved in the study as data was collected during the school day.

**Consent Procedures**

To ensure transparency with the investigation, I clearly explained the study to students and asked if they had questions. For both classroom observations and student interviews, I obtained parental consent. I further described how I would maintain confidentiality with the data via the use of pseudonyms. For instance, I assigned random numbers to students - (student # 10 Italian School A). Furthermore, I informed the students they were allowed to withdraw from the study at any time without a reason. Students participating in the study received a copy of consent form with their signature. Lastly, throughout the study, I checked in with students periodically to see if they had any questions regarding any aspect of the process. In this manner I ensured fair treatment of student participants.

**Subject Costs and Compensation**

Students and teachers did not receive compensation for participating in the study, nor did they incur any expenses. Students were asked to participate during either their community lunch and learn period or study hall. Teachers completed the questionnaire
during their preparatory period or common planning time (CPT). No extra funding was needed or time used from instructional class periods to conduct the investigation. Overall, attendance was taken with the students only, yet participation was always voluntary.

Emphasizing the individual learner and meaning-making, then, students’ perspectives of the digital lab experience and its effects were explored. Specific attention was geared towards the extent the lab altered their feelings of competence, motivation for tasks, and most importantly, self-efficacy in second language acquisition. Furthermore, using a theoretical framework, research questions, coding, and an inductive approach supported by Strauss and Corbin (1990, 1998), the study provided pertinent data. Consequently, an inductive approach supported the constructivist worldview as new knowledge regarding students’ understandings emerged over time.

Components of grounded theory, then, defined by Glaser and Strauss (1967), (Glaser, 1978), and (Strauss, 1987) were utilized including: a) simultaneous involvement in data collection and analysis, b) constructing codes and categories from data, c) using the constant comparison method at each stage of the analysis, d) advancing theory development during each step of data collection and analysis, e) memo-writing to elaborate categories, specify their properties, and define relationships between categories and gaps, and f) sampling aimed toward theory construction. Consequently, using grounded theory methods along the way provided a venue for the analysis of substantive data.

Data Collection Methods

Sources of data were diverse in nature and triangulated. Data included findings from a student self-efficacy survey (see Appendix B), a teacher questionnaire (see
Appendix C), a class observation protocol (see Appendix D), a student interview protocol (see Appendix E), and material culture (lesson plans and digital artifacts). There existed no exclusion criteria for the study. With respect to field notes, I observed the students using the digital lab throughout the various classrooms and media center using an approved protocol. In the fall and winter, I interviewed students using the protocol during a 50-minute lunch and learn time period, so as not to disrupt daily class schedules.

As soon as permissible after interviewing, I administered the self-efficacy survey which was an instrument measuring two main components – self-efficacy for course content and self-efficacy for online technology. It took the form of an adapted, Eccles and Wigfield (1995) survey and online technology survey from Miltiadou and Yu’s (in press) Online Technologies Self-efficacy Scale (OTSES) (see Appendix B). Regarding the original survey, a total of 27, 5-point Likert-scaled items were developed. The first three items measuring course content self-efficacy were generated based on Eccles and Wigfield’s (1995) 7-point Likert-scaled items. The last 24 items measuring online technologies were developed based on Miltiadou and Yu’s (in press) Online Technologies Self-Efficacy Scale (OTSES). Each statement was preceded by the phrase “I feel confident…” For each item, students were asked to indicate their attitude from “Strongly Disagree,” “Disagree,” “Neutral,” “Agree,” to “Strongly Agree.” Students were asked to select the option “Strongly Disagree” if they did not understand the statement. As the survey was a fairly loose adaption of the original, I did not need permission for the scale.

The original instrument was tested in a pilot study conducted with 32 students. It was uploaded on the Internet, and participating students were asked to complete it online.
Reliability analysis (Cronbach’s coefficient alpha) showed that the reliability was .87 for the first three items measuring content self-efficacy and .90 for the remaining 24 items measuring online technologies self-efficacy. Sample items included statements such as “I feel confident doing well in this course,” “I feel confident forwarding an e-mail message,” and “I feel confident downloading (saving) a file from discussion area when needed.”

The teacher questionnaire was administered in the fall 2018 (see Appendix C). The premise was to create a Google document for both the student survey and teacher questionnaire. The world language departments at both schools were apprised of the study’s purpose and scope, yet they did not need to serve as focus groups as data sources were already plentiful.

I constantly engaged in memo-writing to keep track of my reflections of the data and to compare trends or contradictions. In this way I practiced reflexivity. Reflexivity is the process of reflecting upon yourself as the researcher, to provide a more effective and impartial analysis. It involves examining and consciously acknowledging the assumptions and preconceptions you bring into the research and that therefore shape the outcome. None of us are detached, objective observers. We are all human beings who hold opinions and pre-formulated ideas, based on our experiences and what we have been exposed to in our lives. Reflexivity, then, occurs when a researcher looks at herself making sense of how someone else makes sense of her world (Rossman & Rallis, 2017, p. 37).
Data Analysis Methods

Initial data was collected from the participants and then coded. All codes were recorded in a codebook. Focused coding then prompted categorization. According to Tweed and Charmaz (2012), raw data and descriptive codes form building blocks, a foundational base of a pyramid, in which there exists a gradual movement to more sophisticated, abstraction and interpretation (p. 132). Saldaña (2016, p. 25) contends that the final number of major themes or concepts should be held to a minimum to keep the analysis coherent, but there is no standardized or set number to achieve. Nevertheless, Saldana’s concept of a trinity of codes to assess a theme’s importance or theme interrelationships was helpful. Adapting a visual representation of grounded theory created by Tweed, the process was very scientific, but not linear (see Figure 9).

Figure 9. Adapted from “Diagram of the Grounded Theory Process.” Tweed, A., & Charmaz, K. Copyright 2012.
Issues of Trustworthiness

Validity, credibility, and trustworthiness relating to data collection.

The trustworthiness of the data and instruments was established via four main areas. First, credibility is the confidence of the researcher in the truth of the study’s outcomes. Using triangulation of data (interviewing, observation field notes, surveys, and material culture), I ensured the outcomes were credible. Second, transferability is how the researcher shows that the findings can be applied to other contexts. Using thick description of the setting, participants, and obstacles, I demonstrated how other similar populations benefitted from the study results. Next, confirmability is the degree outcomes are based on the participants’ responses and not on any biases or motivations of the researcher. As a qualitative researcher, I provided an audit trail which showed every step of the data analysis to provide a rationale for the decisions made. Lastly, dependability refers to the extent the study can be repeated by other researchers and the results remain the same. To ensure dependability, I had outside reviewers examine the research process and analysis to ensure the results were consistent and could be repeated.

Validity, credibility, and trustworthiness relating to data analysis.

There were different ways to ensure the credibility of data analysis. For instance, I remained open to alterations, avoided overlaps, considered previous categories, and had a strong grasp of the data (Glaser & Strauss, 1967). Additionally, I strove to describe category properties to justify inclusion of each data bit and provide a basis for later tests of replicability (Lincoln & Guba, 1985, p. 347).
Limitations and Delimitations

As I served as both the researcher and the world language supervisor, I realized I wore two “hats”. The investigation, then, was an emic study. Therefore, I collected data from a sister school that had adopted the same program. In addition, I ensured all approvals were in place for the students and staff. This step required filing all the proper paperwork for Rowan University as well as securing approvals from the district prior to conducting the study.

Summary

The research questions for the study connected with both the qualitative inquiry and grounded methods as well as the information from the literature review. The questions probed students about their experiences with the program and self-efficacy beliefs. The literature suggested that students with a higher sense of self-efficacy achieved more in second language acquisition. Additionally, qualitative research on secondary students’ self-efficacy and language learning had been understudied. Furthermore, qualitative inquiry, with its emphasis on interviewing in the field, thick description, and collection of material culture, paired nicely with the goals of the investigation.
Chapter 4

Introduction

The goal of the study was to determine students’ self-efficacy in second language acquisition upon the use of the ReLANpro digital language lab throughout Italian and Spanish classrooms at two high schools in one regional high school district in the Northeastern United States as well as teachers’ perceptions of the program. A total of 27 students took part in the investigation. Ten of the 27 students participated in interviews. Twenty-seven students completed an online survey regarding language learning and ReLANpro. I completed five classroom observations and collected 12 questionnaires from world language teachers. The order of the data collection was as follows: 1) class observations, 2) teacher questionnaire 3) student interviews, and 4) student survey. I followed this order to ensure the survey did not influence student interviews in any way. I collected material culture and wrote analytical memos throughout the study.

Using the different data sources, I satisfied the research questions. The questions included:

- What are students’ perceptions of the effectiveness of the ReLANpro digital language lab on their self-efficacy in language production?,
- How do students describe their experience using the ReLANpro digital lab?,
- To what extent are students afforded language learning opportunities in speaking, writing, reading, and listening upon the use of ReLANpro as measured by artifacts?, and
What are teachers’ perceptions of the effectiveness of the lab and recommendations for best practices in both training and implementation?

The questions served as a necessary foundation for reflection and assessment of the value of the lab’s influence on students’ self-efficacy in language learning and teachers’ reactions related thereto. This section will address the answers to each of the research questions, delve into the themes emerging from the qualitative investigation, and discuss other factors and bi-products of implementing this resource in a secondary environment.

When considering students’ self-efficacy and the first research question, the program had a positive effect on their attitude toward language learning and confidence as evident from interviews and online survey results. Six students out of 10 said in interviews that the program added to their confidence. With respect to survey responses, students also scored high in confidence-related questions (agree and strongly agree combined) in such topical areas as: understanding ReLANpro functions (66.6%), recording speaking (62.9%), speaking with classmates (51.8%), listening (55.5%), reading (70.3%), listening to the teacher’s prompts and responding (81.5%), using the chrome books with the ReLANpro app (63.9%), and practicing the language (88.8%). Consequently, these areas stood out as positively contributing to students’ self-efficacy.

Regarding students’ experience with the program and types of opportunities undertaken, 10 students out of 10 said, first and foremost, that the program allowed for or provided needed practice. Five students out of 10 further expressed they preferred the use of the digital language lab in the world language classroom, noting the technology was a welcomed break from the traditional lesson format. They further said that although
grammar and speaking presented challenges (see Appendix J), the program prompted improvement in these areas. Four out of 10 students indicated the lab helped them prepare for the AP College Board and course assessments. Moreover, four out of 10 students expressed interest in the program’s paired speaking function in which they had an opportunity to learn from their peers’ responses and feedback. Thus, students expressed many positives regarding the program.

This chapter will be organized according to the specific themes which emerged from the data analysis - namely student self-efficacy/confidence, practice, and technology. Furthermore, a discussion surrounding assessment and teacher persistence will follow the explanation of the themes as the two topics played a part in the study’s overall findings. Then, a discussion of the technology with a company representation and the response from teachers will be described.

**Student Self-Efficacy**

The student survey and interviews provided insight into pupils’ perspectives of their language learning and attitudes toward the ReLANpro digital lab. The student survey questions were divided into questions of confidence regarding course content and questions of confidence with ReLANpro. I sent the survey protocol electronically to 28 students of Italian and Spanish, and 27 students responded. This represented a 96.4% response rate which was favorable.

The first part of the survey required students to note their language of study (Italian or Spanish) (see Figure 10), year of study (see Figure 11), and level of course (see Figure 12). I constructed the survey, so students had to respond to each question. Also, I configured the instrument, so the responses to the first three items populated a pie chart
whereas the answers to the survey questions on ReLANpro and student confidence in language learning were presented via bar graphs. As the possible responses ranged from strongly disagree to strongly agree in a Likert-type format (1 to 5), it was visually easier to see responses in a bar chart in which strongly disagree appeared on the far left and strongly agree on the far right. The participant characteristics are as follows:

**Figure 10.** Participant Characteristics – Language of Study. The chart depicts the breakdown of Italian and Spanish participants in the study.

**Figure 11.** Participant Characteristics – Level of Study. The chart depicts the instructional levels of the different Italian and Spanish students surveyed.
Figure 12. Participant Characteristics – Year of Course. The chart depicts the year of study of various participants.

From the charts it is evident that more of the participants are from Italian classes (63%) than Spanish (37%). Also, more of the students are from the accelerated grouping (63%) although representation existed from different leveled courses. There existed no participants in the modified level. Lastly, considering Italian and Spanish students, a higher percentage (59.3%) are in “Year One” of their language learning experience.

The student survey results indicated confidence or self-efficacy in particular areas. Out of 27 respondents, students expressed confidence (combined agree and strongly agree) in such areas as completing class assignments (77.7%), participating in group projects (81.5%), reading (74.1%) and writing (62.9%) in class, but not as much confidence with speaking (44.4%). However, with respect to confidence in speaking and the use of ReLANpro, I discovered the scores to be higher. Speaking with classmates was (51.8%) and recording speech was (62.9%). Additionally, students responded positively
regarding their knowledge of the various functions of the program (66.6%), yet did not respond favorably regarding the ease of use of the system (22.2% - strongly disagree and agree). The following tables show student responses regarding ReLANpro’s ease of use by language of study, year of study, and instructional level.

Table 3

*Response by Italian Students – ReLANpro Ease of Use N=17*

<table>
<thead>
<tr>
<th>Respondent</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>7</td>
<td>4</td>
</tr>
<tr>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>3</td>
</tr>
<tr>
<td>11</td>
<td>3</td>
</tr>
<tr>
<td>12</td>
<td>4</td>
</tr>
<tr>
<td>13</td>
<td>4</td>
</tr>
<tr>
<td>14</td>
<td>3</td>
</tr>
</tbody>
</table>
Table 3 (continued)

<table>
<thead>
<tr>
<th>Respondent</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>3</td>
</tr>
<tr>
<td>16</td>
<td>4</td>
</tr>
<tr>
<td>17</td>
<td>5</td>
</tr>
</tbody>
</table>

*Note.* Survey responses from Italian students. $M=3.47$ (neutral)

When considering a program’s ease of use, a positive score would fall into agree or strongly agree (4 or higher).

Table 4

*Response by Spanish Students – ReLANpro Ease of Use $N=10$*

<table>
<thead>
<tr>
<th>Respondents</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>6</td>
<td>3</td>
</tr>
<tr>
<td>7</td>
<td>3</td>
</tr>
<tr>
<td>8</td>
<td>4</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
</tr>
</tbody>
</table>

*Note.* Spanish students’ responded to the ReLANpro question on ease of use. $M=2.8$
Spanish students scored ease of use even lower than Italian students. Hence, the responses leaned towards “disagree.”

Table 5

*Italian and Spanish Students Year 1 to 4 – Response to ReLANpro Ease of Use N= 27*

<table>
<thead>
<tr>
<th>Year of Study</th>
<th>Strongly Disagree</th>
<th>Disagree</th>
<th>Neutral</th>
<th>Agree</th>
<th>Strongly Agree</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>2</td>
<td>4</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

*Note.* Participants response on the ease of use of the program.

Although seven, first-year students responded agree or higher to ease of use, seven from the group across years of study responded strongly disagree and disagree.

Table 6

*Response to ReLANpro Ease of Use by Instructional Level N=27*

<table>
<thead>
<tr>
<th>Instructional Level</th>
<th>Strongly Disagree</th>
<th>Disagree</th>
<th>Neutral</th>
<th>Agree</th>
<th>Strongly Agree</th>
</tr>
</thead>
<tbody>
<tr>
<td>College Prep</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Accelerated</td>
<td>2</td>
<td>2</td>
<td>4</td>
<td>7</td>
<td>3</td>
</tr>
<tr>
<td>Honors</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Advanced Placement</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

*Note.* The table depicts student responses to ReLANpro ease of use per level.
The accelerated class comprised the largest of the instructional groups with eighteen out of the twenty-seven participants in the study. Considering all instructional levels, however, fourteen students actually responded neutral or below to the question regarding ReLANpro’s ease of use. The responses regarding ease of use, however, may have been attributed to such things as occasional wifi issues throughout the buildings or the amount and type of training on the lab.

Considering student interviews as another data set, I was able to delve more into student self-efficacy with the program. Two students said the lab helped them to remember and “put the words in my brain.” Moreover, nine of the 10 students said that it helped them learn the target language and language production. It was interesting to note that first year students preferred that the lab allowed them to find the right words for a response and take more time in answering. In contrast the AP students appreciated that the lab helped them practice at more native speeds. Therefore, students used the lab in different ways based upon their year of language learning (Year 1, Year 2, etc.) as well as their instructional level. For instance, year one students liked to practice answering teachers’ pre-recorded prompts, identifying items from a picture, or forming more basic sentence constructions with common verb forms. They also liked expressing the language in both formal and informal ways as well as listening to a peer via paired speaking sessions. Year 4 students, however, dubbed over video, wrote subtitles to video, and practiced more complex vocabulary. Advanced Placement students enjoyed enhancing their fluency via speaking at quicker speeds using the lab and practicing circumlocution.

Interviewing students over time, I noticed specific similarities in responses regarding language learning. For example, students said they enjoyed learning about
culture and speaking in the target language. One student, in particular, indicated her mother was from Chile, and she liked using ReLANpro to learn the language to be able to communicate more effectively with her mother in Spanish. Other students indicated they enjoyed the paired speaking exercise with ReLANpro, noting their peers offered useful suggestions in pronunciation and grammar. Some even noted they liked “to hear their own voice” as it showed them where they were “jerky” or “not fluid” with speaking. For instance, one student noted she realized the presence of a “double ll” at the beginning of a word remains silent and is pronounced like a “y” in Spanish via her use of ReLANpro and the paired speaking exercise. Overall, students remarked the program was a “useful tool”, “pretty easy”, “provides a wide variety of things other than just speaking”, and “the idea is a good one.”

Interviewing students, I was able to discern what students considered the benefits of the program with respect to their language learning experience. First, all students noted that learning about culture was something they really liked. They indicated studying a language and the culture of its people was something useful in the present and the future. With respect to listening and speaking at what they called “the native level”, four students shared ReLANpro helped them self-assess their fluidity in the language and discern where gaps may exist in their speaking.

With respect to an appreciation of Italian culture and response to the question: “What do you like most about learning a world language?”, students noted such things as:

- “I am Italian. It is my culture, so I am interested in learning it.”
- “Learning Italian brings me into a different culture and allows me to learn how people live differently outside the US. Growing up here, you are so confined in many ways.”

- “Learning a world language broadens your experiences.”

In this sense students used the language to investigate, explain, and reflect upon the relationship between the practices and perspectives of the people of Italy compared to their own. A few of the students came from an Italian background, but none of the students in the study were native speakers. The program did lend itself towards cultural learning as teachers uploaded more authentic audio digital files and video materials to enhance students’ overall experience with the target language. Thus, students in both schools shared that studying culture was one of their favorite aspects of language learning, and the program supported this goal.

As nuances of a language also comprise one characteristic of a culture, the students further expressed that learning to speak in the target language was key to their language learning. Teachers posted native speaker files on the program for students to listen and get accustomed to the fluidity of speech. When prompted if the ReLANpro lab complemented their language learning in any way, students responded:

- “With my production of the language, it helps me speak faster and get everything out.”

- “It helps me see gaps in my speaking.”

- “It helps me speak more at the native level.”

- “It helps me think more on the spot and forces me to think in the moment.”
- “It helps me better prepare for/understand what the AP test is going to be like.”
- “It makes me more adapted to hearing Italian at a faster pace.”

Overall, the students said the program made them more confident in the sense they were able to practice speaking faster and discover what words they did/did not know. Furthermore, they indicated the program helped them fine-tune their pronunciations of different words.

The theme counts for self-efficacy were detectable primarily from student surveys and student interviews rather than class observations and the teacher questionnaire. Considering the student surveys, confidence appeared 16 times. Throughout the student interviews, confidence or its near equivalent appeared 15 times. Therefore, the total count for this theme was 31.

**Practice**

Through analyzing 10 student interviews, 27 student surveys, five classroom visitations, and findings from a teacher questionnaire, the responses indicated practice to be a benefit of the program. Observing an AP Italian class comprised of nine students, for example, I witnessed the students using the lab in multiple ways, particularly with respect to listening and speaking skills. I saw the group confidently logging onto the ReLANpro program, listening to an audio, and then responding to their teacher’s questions via a class discussion. I also witnessed them speaking in pairs about winter vacation plans, followed by practicing speaking at native speeds in response to a cultural comparison prompt.

Mr. D (pseudonymic abbreviation) indicated the activities that day entailed using the ReLANpro lab in different ways to practice and prepare for the impending College
Board AP Italian test. At the onset of the lesson, Mr. D clarified his objectives for the class which read as follows: 1) You will be able to engage in interpersonal conversation regarding your future, and 2) You will be able to compare and contrast where Italians and Americans meet up to socialize (see Figure 13).

![AP Italian Mastery Objectives](image)

*Figure 13. AP Italian Mastery Objectives. School B Italian teacher’s mastery objectives are visible as well as the ReLANpro student interface.*

Mr. D first asked students to complete a listening exercise via ReLANpro using the headsets and a pre-recorded prompt on the system. He then posed questions of the class orally, assessing how well they listened in the target language via determining how
many details they were able both to recall and describe in the target language. As it was a small class, he asked each student to share details from the listening exercise. He judged responses informally, yet listened for the number of details students could recall from what they had heard. Next, students completed a paired exercise in which they spoke with a partner about about their impending winter break activities using the future tense. During this time Mr. D listened to the paired conversations using the lab (see Figure 14).

![Figure 14. Teacher Computer View of Paired Conversations. The teacher’s computer shows students’ paired conversations on the right which Mr. D recorded.]

For the final activity, Mr. D provided an exercise on ReLANpro in which students practiced speaking continuously for two minutes upon listening to an Advanced Placement cultural comparison prompt. Students completed this activity twice with approximately five to seven minutes in between each attempt. Between the first and second practice, Mr. D elaborated upon different ways students could enhance their
speaking momentum via using transitional words like “però” and offering personal examples (see Figure 15).

Figure 15. Teacher Offers Students Tips. Mr. D offers students tips regarding how to enhance their speaking pacing and fluency.

Overall, Mr. D emphasized the importance of pacing and fluency asserting, “If a word is said quickly in Italian, don’t drag it out.” He suggested taking the first minute to brainstorm similarities and differences between the locales Americans meet up to socialize versus the locales Italians meet up to socialize followed by speaking. Another suggestion Mr. D made was to integrate the similarities and differences rather than to list all aspects of the American way of life and then all aspects of the Italian way of life.
Students were engaged and spoke for over 90% of the class period which is a desired goal (see Figure 16). Mr. D further emphasized the importance of comprehensibility versus nuances of grammar. He clarified that those who assess the AP Italian test are not as focused on small nuances of grammar. Rather, according to Mr. D, assessors from the College Board graded students higher who could speak continuously with comprehensibility as opposed to having perfect grammatical structures. Mr. D reminded the students that they should practice circumlocution, or using different, suitable words to express an idea indirectly when trying to search for the exact words. Doing this, according to Mr. D, students had a better chance of preventing long pauses in speech or stuttering. Mr. D further emphasized that building this skill and stamina in communication took ongoing practice.
Aside from class observations, the teacher questionnaire further revealed the theme of practice. I sent the questionnaire to 20 staff at school A and B and received 14 questionnaires back. Two of the questionnaires were not completed. Thus, I used 12 completed questionnaires for this data set. One open-ended question of the instrument was: “What are some of the activities or lessons you have been able to do with ReLANpro?” Teacher responses below are organized according to skill and from highest similar response to lowest (see Table 7).

Table 7

*Teacher Responses to Open-Ended Question N=12*

<table>
<thead>
<tr>
<th>What are some of the activities or lessons you have been able to do with ReLANpro?</th>
<th>Number of Incidences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speaking</td>
<td>22</td>
</tr>
<tr>
<td>Practice</td>
<td>15</td>
</tr>
<tr>
<td>Listening</td>
<td>4</td>
</tr>
<tr>
<td>Writing</td>
<td>2</td>
</tr>
<tr>
<td>Reading</td>
<td>1</td>
</tr>
</tbody>
</table>

*Note.* Teacher feedback favored speaking and practice.

Many of the responses, then, either explicitly stated practice or were activities that lent themselves to practice. Thus, the responses exemplified the diverse nature of practice
opportunities afforded students as a result of teachers implementing the program throughout Spanish and Italian classrooms.

The theme of practice surfaced in the student interviews as well. Through interviewing a total of 10 Spanish and Italian students at both locations, participants emphasized the lab provided needed practice with speaking. One student remarked, “It gives me a practice run of what the AP test is going to be like.” This echoes the teachers’ responses in the aforementioned data set. In fact, the word “practice” or its near equivalent appeared well over 20 times in transcriptions alone (see Table 8). Responses to interview questions are organized from highest to lowest and include:

Table 8

<table>
<thead>
<tr>
<th>Activity</th>
<th>Number of Incidences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Practice</td>
<td>13</td>
</tr>
<tr>
<td>Speaking</td>
<td>10</td>
</tr>
<tr>
<td>Reading</td>
<td>1</td>
</tr>
<tr>
<td>Writing</td>
<td>1</td>
</tr>
</tbody>
</table>

Note. These are the number of incidences per activity noticed via student interviews.

It is important to clarify the characteristics of the participants from which the data derived considering the two schools, the language taught by the teachers, and the students’ language of study (see Table 9).
Table 9

*Student Interview and Teacher Questionnaire Participant Characteristics N=22*

<table>
<thead>
<tr>
<th>School</th>
<th>Students</th>
<th>Teachers</th>
<th>Language - Teachers</th>
<th>Language - Students</th>
</tr>
</thead>
<tbody>
<tr>
<td>School A</td>
<td>6</td>
<td>8</td>
<td>Italian – 2</td>
<td>Italian – 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Italian/Spanish - 1</td>
<td>Spanish – 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Spanish – 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>French - 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>German – 1</td>
<td></td>
</tr>
<tr>
<td>School B</td>
<td>4</td>
<td>4</td>
<td>Italian - 1</td>
<td>Italian – 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Spanish - 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>French – 1</td>
<td></td>
</tr>
</tbody>
</table>

*Note.* More participants are from School A, and Italian is represented more than the other languages.

When considering the data from the student survey, many concurred the language lab offered more personal practice with speaking whereas simply speaking face-to-face with the teacher or in front of peers for class presentations was “awkward”, “nerve-wracking”, “inefficient”, and “everyone is staring at you”. In fact, 88.8% of 27 students or a total of 24 agreed and strongly agreed the program offered practice in the language (see Figure 17).

*Figure 17.* Student Survey Response – Practice with ReLANpro.
Consequently, through class observations, teacher feedback, student interviews, and student survey responses, I discovered the lab provided students different pathways for practice of the target language.

The theme counts for practice came from the student surveys, student interviews, teacher questionnaire, class observations, and material culture such as lesson sets (see Appendix K). With respect to student surveys, the theme of practice surfaced twice. The theme of practice appeared 23 times in student interviews, 15 times in the teacher questionnaire, five times in class observations, and 146 times in material culture. Consequently, the total for all practice theme counts was 191.

**Technology**

Throughout student interviews, the teacher questionnaire, classroom observations, and the student survey, participants offered different feedback regarding ReLANpro’s technology. In interviews, the students noted using the technology to practice speaking was “cool”, “different”, “more laid back”, and “fun”. Moreover, students shared that technology was very much a part of their language learning already with chrome books, Google classroom, Kahoot, Quizlet Live, Conjuguemos, Flip Grid, Peardeck, Gimkit, and Duolingo. Some commented that as they could not always have their phones in the classroom, using a new form of technology such as ReLANpro was a welcomed change.

Although students had many positive things to say about the program, they also expressed the program took a little getting used to. When probed further, they indicated there were “too many buttons”, and the lab could be more “intuitive”. However, through trial and error, students shared they learned what to do/not to do and considered the use of the lab overall a “learning experience.” Students further said that they liked having
control over the pacing of their answers and being able to pause to “fix” a response. Consequently, these digital natives did not seem as fazed by periodic glitches in the system. Rather, they enjoyed the system when it worked properly.

Despite the fact that the study’s focus was on student’s experience with the program, I was also interested in finding out about teacher perspectives, especially pertaining to technology. I sent the survey to 20 world language staff at both schools and received 12 completed surveys (see Table 10). It was very revealing as to perceived strengths and weaknesses of the program. From the 12 survey responses, the feedback was as follows:

Table 10

*Teacher Questionnaire on ReLANpro 2018-2019 N=12*

<table>
<thead>
<tr>
<th>Questions – I feel confident…</th>
<th>SD</th>
<th>D</th>
<th>N</th>
<th>A</th>
<th>SA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependability of the system.</td>
<td>1/12</td>
<td>5/12</td>
<td>2/12</td>
<td>4/12</td>
<td>0/12</td>
</tr>
<tr>
<td></td>
<td>8%</td>
<td>42%</td>
<td>17%</td>
<td>33%</td>
<td>0%</td>
</tr>
<tr>
<td>In teaching students how to use the system.</td>
<td>0/12</td>
<td>1/12</td>
<td>0/12</td>
<td>9/12</td>
<td>2/12</td>
</tr>
<tr>
<td></td>
<td>0%</td>
<td>8%</td>
<td>0%</td>
<td>75%</td>
<td>17%</td>
</tr>
<tr>
<td>In the benefits of the system.</td>
<td>0/12</td>
<td>0/12</td>
<td>2/12</td>
<td>4/12</td>
<td>6/12</td>
</tr>
<tr>
<td></td>
<td>0%</td>
<td>0%</td>
<td>17%</td>
<td>33%</td>
<td>50%</td>
</tr>
</tbody>
</table>
Table 10 (continued)

<table>
<thead>
<tr>
<th>Questions – I feel confident…</th>
<th>SD</th>
<th>D</th>
<th>N</th>
<th>A</th>
<th>SA</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the versatility of the system.</td>
<td>0/12</td>
<td>2/12</td>
<td>3/12</td>
<td>7/12</td>
<td>0/12</td>
</tr>
<tr>
<td></td>
<td>0%</td>
<td>17%</td>
<td>25%</td>
<td>58%</td>
<td>0%</td>
</tr>
<tr>
<td>In the professional training received on the system.</td>
<td>3/12</td>
<td>6/12</td>
<td>0/12</td>
<td>2/12</td>
<td>1/12</td>
</tr>
<tr>
<td></td>
<td>25%</td>
<td>50%</td>
<td>0%</td>
<td>17%</td>
<td>8%</td>
</tr>
<tr>
<td>In the technology assistance with the system.</td>
<td>3/12</td>
<td>4/12</td>
<td>4/12</td>
<td>0/12</td>
<td>1/12</td>
</tr>
<tr>
<td></td>
<td>25%</td>
<td>33%</td>
<td>33%</td>
<td>0%</td>
<td>8%</td>
</tr>
<tr>
<td>In the manner the system supports students’ speaking skills.</td>
<td>0/12</td>
<td>0/12</td>
<td>1/12</td>
<td>5/12</td>
<td>6/12</td>
</tr>
<tr>
<td></td>
<td>0%</td>
<td>0%</td>
<td>8%</td>
<td>42%</td>
<td>50%</td>
</tr>
<tr>
<td>In the manner the system supports students’ writing skills.</td>
<td>1/12</td>
<td>2/12</td>
<td>7/12</td>
<td>2/12</td>
<td>0/12</td>
</tr>
<tr>
<td></td>
<td>8%</td>
<td>17%</td>
<td>58%</td>
<td>17%</td>
<td>0%</td>
</tr>
<tr>
<td>In the manner the system supports students’ listening skills.</td>
<td>0/12</td>
<td>1/12</td>
<td>0/12</td>
<td>4/12</td>
<td>7/12</td>
</tr>
<tr>
<td></td>
<td>0%</td>
<td>8%</td>
<td>0%</td>
<td>33%</td>
<td>58%</td>
</tr>
</tbody>
</table>
Table 10  
(continued)

<table>
<thead>
<tr>
<th>Questions – I feel confident…</th>
<th>SD</th>
<th>D</th>
<th>N</th>
<th>A</th>
<th>SA</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the manner the system supports students’ reading skills.</td>
<td>1/12</td>
<td>1/12</td>
<td>6/12</td>
<td>4/12</td>
<td>0/12</td>
</tr>
<tr>
<td></td>
<td>8%</td>
<td>8%</td>
<td>50%</td>
<td>33%</td>
<td>0%</td>
</tr>
<tr>
<td>In the manner department members have assisted one another with the system.</td>
<td>0/12</td>
<td>0/12</td>
<td>1/12</td>
<td>5/12</td>
<td>6/12</td>
</tr>
<tr>
<td></td>
<td>0%</td>
<td>0%</td>
<td>8%</td>
<td>42%</td>
<td>50%</td>
</tr>
<tr>
<td>In the manner the system has supported formal assessment strategies.</td>
<td>0/12</td>
<td>0/12</td>
<td>2/12</td>
<td>7/12</td>
<td>3/12</td>
</tr>
<tr>
<td></td>
<td>0%</td>
<td>0%</td>
<td>17%</td>
<td>58%</td>
<td>25%</td>
</tr>
</tbody>
</table>

*Note.* Survey results were gathered from teachers across language areas.

The data revealed teachers’ perceptions of the advantages of the lab for students. For instance, teachers responded the lab enhanced students’ listening and speaking skills. In addition, the data showed teachers’ confidence in their abilities to train others (peers and students) despite disagreeing with aspects of the implementation such as training and technological support.

**Quality of program.** Teachers agreed to the overall benefits of the program to students (strongly agree and agree – 83%). Examining specific benefits, teachers indicated the system supported students’ listening skills (91% combined agree and
strongly agree) and speaking skills (92% combined agree and strongly agree). Additionally, teachers responded the program supported their formal assessment strategies (combined agree and strongly agree – 83%). Moreover, teachers expressed that department members assisted one another with the program (combined agree and strongly agree – 92%). Consequently, there existed several benefits for students and teachers.

**Issues with implementation.** Despite these positive responses, educators did not answer as favorably to professional development training on the lab (strongly disagree and disagree – 75%) and technology assistance with the program (strongly disagree and disagree – 58%).

**Growth mindset of educators.** Although the responses were unfavorable to the amount and kind of training, the teachers seemed confident in their ability to teach students how to use the program (strongly agree and agree – 92%) and assist their peers as well (92% strongly agree and agree). Once again, this perseverance on the part of the teacher to experiment and navigate a new program despite obstacles may speak to the resilience educators. It is possible teachers are willing to take such risks with technology and persevere with a new tool if they believe the overall benefits to students are worthwhile.

The periodic issues with the technology occurred in some class observations. Ms. T’s (pseudonymic abbreviation) Italian 4 Honors class was learning about the imperfect tense. For the lesson, she provided the students with the following activity:

**The Simpsons Dub**

Today you will dub a short clip of a Simpsons cartoon. The clip shows Homer Simpson who has taken a picture of himself every day for 39 years. Your task is to describe 15
things that Homer used to do/be when he was younger. You MUST use the Imperfect tense when you are describing things he used to do, or describing him in general. If you are describing something that happened ONCE, you will use the Passato Prossimo.

You must dub at least 15 sentences in the Imperfect during the video. I will give extra credit for 2 correct sentences in the Passato Prossimo.

When you open the assessment on ReLANpro, it will take a minute to download. When you are ready, click PLAY and watch the video. When it is finished, go back to the beginning.

When you are ready to dub, click RECORD. When you see something you want to dub, click GAP, say your first Dub, then click GAP again. You can add GAPS wherever you want. If you want to check how many you have done, click the BOOKMARK button (looks like a bookmark) and you can check your progress. Don’t worry if they seem out of synch with the video, I will get them in order. If you think of another one after you’ve gone through it, you can go back to the beginning, click RECORD and add in a GAP wherever you want. When you are finished, click STOP, then click SUBMIT.

If you start recording and you don’t want to keep what you’ve done, click STOP and click DELETE. BEWARE - you CANNOT delete single bookmarks, it is ALL or NOTHING.

**Characters:**
- Homer
- Il padre di Homer
- La madre di Homer
- Marge
- Elvis - Elvis
- can - la lattina

**Vocabolario utile:**
- stroller - il passeggino
- pacifier - il ciuccio
- bib - il bavaglino
- to gain weight - ingrassare
- to lose weight - perdere peso
- to fail - bocciare
- to repeat - ripetere
- to leak - gocciolare
- pimples - i brufoli
- moustache - i baffi
- beer - la birra
- Taj Mahal - Taj Mahal
- to lose hair - perdere i capelli to dress as - vestirsi come

* The video of Homer Simpson is called “Picture a Day for 39 years”.

Although the lesson involved significant planning and was student-centered, some pupils found success dubbing the imperfect tense, while others did not. Some students’ responses recorded properly on the ReLANpro system. However, other students’ responses and bookmarks did not (were blank). Consequently, when students double
checked the bookmark symbol, there was no audio response. Ms. T circulated to the various students, followed by instructing them to log off and work on Duolingo using the chrome books. She further detailed the ReLANpro activity would be considered a practice with a class participation grade assigned. Therefore, students would not lose points due to a technological glitch in the system.

When Ms. T examined what happened with the system after the class period was over, she realized with videos students should not press “record” as this action writes over the students’ responses. Rather, students should simply press “play”. With pictures or audio, however, students could press “record”, “gap” followed by speaking, and then “gap” again to insert responses. Consequently, Ms. T persevered to determine what went wrong. Speaking with the teacher after the lesson, she expressed that there were “too many buttons” with the system. She did note, though, the same class had used ReLANpro 3-4 other times during the school year with success and without any technological problems during the lesson.

Interestingly, the student survey echoed similar information regarding program ease of use. Specifically, the last question #14 revealed the students’ thoughts about the ease of use of the program (see Figure 18).
Fifty-five percent of respondents answered neutral, disagree, and strongly disagree (combined) with respect to the ease of use of the program. Thus, as one student remarked, “It is good - when it works”.

The theme counts for technology came from primarily from student interviews and the teacher questionnaire. With regards to student interviews, the theme was detected 25 times. With respect to the teacher questionnaire, the theme was present 25 times. Thus, the total count for technology was 50.

**Assessment**

Through classroom observations, the teacher questionnaire, and student interviews, I discovered the resource offered another way for teachers to assess students’ language acquisition as well as provided important feedback to students. Conducting observations, I gleaned an even better sense as to how teachers used the program and student reactions regarding the resource. During the first semester, many of the teachers were still in the process of conducting initial lessons with the digital lab. I observed two Spanish classes and two Italian classes. One of the classes was a Spanish 4 Honors class.
and another was Spanish I Accelerated. Although the classes were not linked to a specific grade level per se, the Spanish 4 class had primarily upperclassmen whereas the Spanish I Accelerated class contained more underclassmen. Nevertheless, it was interesting to witness how the two different Spanish teachers used the program in slightly different ways to assess students’ skills in the target language.

Mrs. V (pseudonymic abbreviation) first distributed an instructional handout of directions for ReLANpro to her students (see Appendix G), chrome books, and headsets. She then modeled the proper way to play her pre-recorded prompts for the students using the ReLANpro system. While the students set up their equipment and logged on, Mrs. V circulated the classroom to ensure everyone was at the proper place in the program. She projected a picture on the board which depicted a busy classroom environment (see Figure 19). The students then used ReLANpro to listen to their teacher’s prompt, followed by describing five things occurring in the picture in the target language. Once the students described the five things, they selected a “submit” button which forwarded the digital file to Mrs. V. Students only submitted the digital file when they felt ready to do so and were satisfied with their work. Additionally, students had control over what they expressed occurred in the picture. Consequently, the students met the task with success. Therefore, they used a variety of vocabulary words, verb tenses, and prepositions to communicate what they saw in the picture using the lab. The exercise, then, allowed for Mrs. V to conduct formal assessment as well as differentiate instruction in the target language.
Figure 19. Picture Prompt and ReLANpro Speaking Exercise. The picture depicts a busy classroom scene. Students described five things happening in Spanish.

For the other Spanish class, students used ReLANpro to respond to five questions regarding their likes and dislikes of activities like sports and dancing using the verb “gustar” which means “to like”. Mr. G (pseudonymic abbreviation) first prompted students’ prior knowledge by posing a few questions about digital labs. He asked: “What is a language lab?” and “What is its purpose?” As this was Mr. G’s first lesson with ReLANpro, he wanted to gauge students’ knowledge of and experience with labs. Mr. G collected student responses on index cards. The information on the cards showed that students’ prior knowledge regarding the purpose of a lab varied widely as some knew it involved online learning to improve communication while others thought it was a place or country. This information was important for Mr. G to know for planning purposes as he could spend some time dispelling student misconceptions about the purpose of the resource.
Upon prompting students with questions about the lab, Mr. G shared an instruction sheet with the students (very similar to Mrs. V’s) and distributed the equipment (chrome books, headsets). He then guided the students through the directions. Students next completed the activity, expressing their likes and dislikes of various activities using the verb “gustar” (see Figure 20). With both Spanish classes, there existed no glitches with technology during the actual lesson, and students in both classes completed the tasks as assigned by each teacher. Hence, the activity served as an assessment as students had to: 1) use the verb “gustar” properly throughout five sentences, and 2) express both likes and dislikes. Mr. G graded the assignment via accessing the bookmarks created in ReLANpro and listening to student recordings. He expressed that being able to go directly to student responses through the bookmarks made grading easier and quicker.

*Figure 20. Student Use of ReLANpro and Chrome books. Students use ReLANpro to express likes and dislikes using the verb “gustar”.*
For the Italian classes, one class was conducted in the media center and the other was conducted in a classroom. Mr. C (pseudonymic abbreviation) used a set of directions to guide his students through the ReLANpro exercise in the media center (see Appendix F). For the lesson the students had to complete two tasks – one formal and one informal. For the first task, students listened to the instructor’s prompt using ReLANpro, followed by answering questions in an informal manner. The second task required students to listen once again (replay), but then restate the questions formally. This second task was a little confusing to the students as they had to restate instead of answer. Nevertheless, the students completed the tasks with success. While observing, I could hear students express, “This is weird (recording their own voice). I think I did good!” Consequently, Mr. C provided a lesson which allowed him to assess a language skill he had previously taught to his students – the proper construction of formal and informal statements in Italian (see Figure 21).

Figure 21. Italian I Students. Students use ReLANpro to produce formal and informal statements in the media center.
Students seemed to prefer speaking all at one time as a group into the ReLANpro program, commenting their teacher could take time at home to listen closely to what they were saying and assess the recording. They also said the teacher could play a student recording for the whole class to teach a particular concept. Nevertheless, despite the preference for the ReLANpro program, the majority of students expressed they understood the value of the teacher assessing in multiple ways – face-to-face, class discussion, and oral presentations in front of the class because “as you get older you need more experience talking face-to-face with people”. Moreover, several students indicated that spontaneous conversations were difficult, and the program encouraged them to produce the language more which would assist them with spontaneous speaking.

Through analyzing responses to the last question of the teacher questionnaire (see Table 9), I learned that 10 out of 12 respondents or 83% of teachers agreed and strongly agreed (combined) to the prompt that the ReLANpro program supported formal assessment strategies. Therefore, through diverse data sources, assessment emerged as another benefit to the program.

**Teacher Persistence With Implementation Efforts**

Throughout ongoing investigation, I noticed world language teachers persevering despite not having all of the answers regarding the system at their fingertips. For instance, many created their own “start-up” and “troubleshooting” guides at both schools (see Appendices H, I). As the company did not provide a user’s manual per se, teachers at both schools developed their own guides appropriate to their school, students, and curriculum to help stakeholders acclimate to and navigate the program. Then, two lead teachers at School A turnkey trained their own department, followed by visiting sister
schools to train other world language departments. Thus, teachers training other teachers became the preferred venue to implement the program. The message below is from a world language teacher at a sister school who was very pleased with the turnkey training (see Figure 22).

Lea and Raina (pseudonyms),

Thank you so much for your help today! It was SO much better than the ReLANPro presentation. I actually was able to create an assignment as a teacher, record the assignment as a student, and play it back to grade it as a teacher. Your directions were clear, and you guys were so patient with everyone.

Thanks, again!!!
Mil gracias / Grazie Mille

Tammy (pseudonym, Spanish teacher and coordinator)

*Figure 22. Teacher Letter to Peer. A letter from a teacher to a fellow peer shows preference for in-house turnkey training.*

The lead teachers showed other teachers the program from two perspectives – teacher view and student view. Also, they presented the program after teachers had their teaching assignments and class rosters fully logged into the system. Moreover, they specifically showed teachers how to create lesson sets and record their voice like students to simulate more closely what would occur in the classroom. Furthermore, they shared the various ways the program could be used to enhance the existing curriculum and promote language acquisition. This knowledge of the specific expectations for student language learning outcomes is something an outside company would not be privy to or be able to deliver in the same, tailored way. Consequently, teachers who used their own
lessons and experimented with the lab seemed more empowered, and their students benefitted in the process.

Other events during the study showed educator persistence with implementing the ReLANpro digital lab. In February 2019 district coordinators and administrators met to discuss the technical glitches experienced with the program and to reach out to the company. The senior supervisor led a conference call with a ReLANpro representative. After sharing the specific problems, the representative agreed to visit the schools free of charge to observe the teachers working with the program and address any technological problems. After hearing this news, the world language teachers decided to use impending in-service time to plan ReLANpro lessons which included many of the program’s functions for the representative to see. This way, if a technological problem arose, the representative could address issues on the spot. Teachers planned the schedule for the representative’s visit (see Appendix L).

Consequently, the conference call and subsequent teacher planning time at the in-service for the ReLANpro representative’s visitation showed problem-solving and reflected Fullan’s (2001) implementation dip. In other words, as learning communities adjust to new programs, they experience ups and downs navigating their way with new resources and sharing experiences, both positive and negative. Moreover, Argyris and Schön (1974) discuss how learners negotiate meaning, communicate with others, and reflect, all leading towards double loop learning (see Figure 23). Without this deeper level of learning, systemic change does not typically occur.
He first updated all of the software on the media center computers to the newest version of ReLANpro. Then, he guided the teachers through the different functions of the program in a more detailed way, explaining how the various aspects of the program worked while the teachers took notes and asked questions. Teachers took notes and developed additional, in-house directions (See Appendix M). This time, he noted what the functions could and could not do with more specificity. Additionally, he emphasized that the schools must have a shared drive that both students and teachers could access to do the paired speaking. I quickly asked the technology support person, who was in attendance, to develop such a shared drive. The staff member complied, but I could not help but wonder if the implementation would have gone more smoothly if the district still had a technology director who was in charge of implementing or guiding technological resources to support instruction. Due to budgetary constraints caused by a lack of funding
from the State, the position had to be dissolved. Nevertheless, the ReLANpro representative further indicated that the schools’ headsets needed to be upgraded and the headset should be plugged into the back of the computer – not front – to avoid any interference of the signals. Some of these missing elements could have been the cause for the technological glitches noticed earlier in the year. Lastly, in the days following the representative’s visit, he sent a link for a new user’s manual to complement the upgraded software.

Consequently, this cognitive dissonance on the part of the teachers or negotiation of opposing beliefs represents a natural order in the learning process. It can have highs and lows - periods of frustration, periods of disbelief in the value of a program, periods of reflection, periods of “aha” moments and success, and periods of acceptance. Therefore, this is a very natural part or aspect of learning. When a group initially does not have full success with a program and has formed one belief and then the same group witnesses why it did not work and how it can work more efficiently, teacher beliefs are challenged internally.

Summary

Over the course of two semesters, I collected data regarding students’ self-efficacy upon the implementation of a new digital language lab called ReLANpro throughout Italian and Spanish classrooms at two different high schools in one regional high school district. Specifically, I surveyed 27 students and interviewed 10 students. Additionally, I observed five classes and administered a teacher questionnaire to 20 teachers at both schools receiving 12 completed surveys. Furthermore, I collected material culture such as teacher lesson plans for ReLANpro as well as other artifacts such
as teacher-created user guides. I discovered that students do like to have digital lab technology to enhance their language learning and prefer to have this technology to practice speaking in particular. Additionally, I learned that students do find speaking in the target language in front of their teachers and peers nerve-wracking, and they like hearing their own voice as this helps them with pronunciation, grammar, and fluency. Consequently, the lab served different purposes for students as they blazed their own pathways towards individual language outcomes.

Throughout administering the various protocols, then, it became evident that students liked taking ownership of their own language learning throughout using the various functions of the ReLANpro digital language lab. As I spoke with students with various years of language learning and different levels of instruction, I learned that advanced students focused on speed and fluidity whereas beginners concentrated on slowing down their speaking pace to select the right words to respond to particular prompts. Also, students’ experiences with the program varied according to the emphasis the teacher placed on different aspects of the program and lessonsets to support the curriculum. Moreover, the teachers’ willingness to experiment and persevere with the program also either positively contributed to or subtracted from the students’ experience with the program.

After coding the data, reflecting, and analyzing the totality of the codes to determine commonalities, it became clear the themes of self-efficacy/confidence, practice, and technology were prevalent and grounded in the research throughout students’ comments, material culture, and survey responses. Thus, the theme counts
previously described indicated specific trends in stakeholders’ experience with the program.
Chapter 5

Introduction

In this study I set out to discover students’ experience and sense of self-efficacy with a digital language lab called ReLANpro Cloud and Class in Italian and Spanish classrooms throughout two high schools in one regional school district located in the Northeastern United States. Specifically, using qualitative inquiry, I interviewed 10 students and surveyed 27 students and 12 teachers. Moreover, I conducted observations in Italian and Spanish classrooms and collected material culture (lessons, handouts, teacher-created guides, etc.). These varied data sources helped provide insights into students’ perceptions of language learning upon their use of ReLANpro digital language lab.

Notable Findings

The findings confirmed some initial assumptions about second language acquisition and self-efficacy but also presented new understandings. I discovered students generally liked using the lab as it offered a welcomed break from the traditional lesson design, provided timely feedback on their use of the language, and contributed further to cultural understandings. This is consistent with what Bandura (1997) termed mastery experiences in which learners gain belief in their capabilities to accomplish tasks through doing. These results are further in line with (Prawat & Floden, 1994) who asserted that an individual’s feelings of competence and belief in his or her potential to solve problems is derived from first-hand experience and is more powerful than any external acknowledgement or motivation.
Students also said that the lab provided a more diverse way to practice which lowered their anxiety about language learning. Without always being “on stage” producing the language, they were able to focus more on their skills in language production which contributed to their self-efficacy. Bandura (1997) described how one’s emotional and physiological state has a direct influence on self-efficacy. Hence, when students’ anxiety levels dropped, they were better equipped to believe in their abilities. Moreover, students said that practicing with peers via the paired speaking function was a “learning experience” and “fun.” Learning from others or role models describes Bandura’s vicarious experiences in which the self-efficacy of others promotes positive beliefs about the self. Consequently, a learner may absorb positive feelings from a role model which can enhance his or her self-efficacy.

Learners benefitted from differentiated instruction opportunities and different pathways to proficiency. In educational environments, it is so important for students to have different ways to practice and demonstrate new skills. In the study first year language students used the lab to slow down their speech to apply the correct terms and grammar whereas advanced students used the lab to build fluency in speaking at more native levels in preparation for the AP College Board assessment. As advanced students improved their fluency, they gained more control of their own learning processes. Student success, then, with the various digital lessons contributed to their sense of motivation which, in turn, boosted their self-efficacy.

Student motivation to engage in language learning, then, was a positive result of the program. Students showed interest with the lab as they accomplished different tasks in reading, writing, listening, and speaking in the target language. Also, although classes
experienced some technological issues with the lab, students still persevered. Hence, they welcomed further experimentation which showed their increased self-efficacy. Moreover, teachers’ verbal persuasion of students to try different lab activities and tasks further strengthened their belief they had what it took to succeed. Therefore, verbal persuasion, another component of Bandura’s theory, was a contributor to learners’ self-efficacy beliefs.

As students worked with the program, they also set personal goals for such language elements as fluency, grammar, and usage as applicable to the teacher’s lessons on the system. Dweck (2006) described the underlying beliefs people have about learning and intelligence and coined the term “growth mindset”. When students believe they can get smarter, they understand that effort makes them stronger. Therefore, they put in extra time and effort, and that leads to greater achievement.

The study also showed that student attitudes towards the lab could be influenced by the teacher’s willingness to experiment with and use the resource. Moreover, this willingness on the teacher’s part to incorporate the lab into instruction stemmed not only from their general persistence with learning and confidence, but also it reflected the actual implementation structure and professional development training related thereto. Consequently, the connection between the teacher’s self-efficacy in implementing a digital resource into instruction and students’ self-efficacy with language learning is a worthwhile topic to examine fully via subsequent studies.

**Contribution to Existing Studies**

The study sought to fill gaps within the existing literature. The existing studies had not focused qualitatively on secondary students’ perspectives of ReLANpro as
contributing to self-efficacy and language learning. Additionally, students at the secondary level are often overlooked as they experience different access to language learning opportunities. One reason for this is teachers typically have fairly large class sizes which makes it hard for them to provide all students enough speaking time and to assess speaking effectively. Also, states require varying expectations of secondary students in world languages, and districts offer various languages, instructional times, and resources to pupils which contributes further to the problem. Thus, high school students may be the group that experience the greatest inequities in instruction. Consequently, examining the effects of a blended learning resource on students’ self-efficacy seems particularly more impactful at the high school level.

**Research Questions Revisited**

To determine the influence of a blended resource on secondary students’ self-efficacy in language acquisition, the research questions focused on students’ interactions with the program and thoughts related thereto. Seeking answers to the questions through multiple sources, I was able to find instances of repetition and contrast in the data.

In the following sections, I will revisit the research questions as they connect with the data and the existing literature. Furthermore, I will explore implications for practice, leadership, social justice, future research, and conclude with recommendations for districts seeking to implement digital language labs effectively throughout world language programs.
Discussion

Research questions. The questions guiding the study focused on the students’ perceptions of the resource and the extent it altered their second language acquisition experience.

What are students’ perceptions of the effectiveness of the ReLANpro digital language lab on their self-efficacy in language production?

Self-efficacy. As students interacted with the lab, they took more ownership over their personal language learning experience. Bandura (1977) coined the term self-efficacy as one's belief in his or her ability to succeed in specific situations or accomplish a task. Moreover, Bandura’s social cognitive theory describes how individuals acquire knowledge through watching others and interacting with media in the environment. Observing classes, I noticed how teachers modeled for students how to use the program, providing step-by-step directions with a teacher-created user’s guide. Eventually, through following models students were able to practice speaking at their own pace and effectively blaze their own trail towards individual language outcomes. Consequently, student agency became a key byproduct of the program as learners focused on different aspects of language learning based upon their own interests and personal language goals. Student agency, then, supported learners’ self-efficacy in accomplishing language tasks.

Feedback. Students shared that the lab allowed them to receive a different kind of feedback regarding their skills producing the language. Rather than waiting for the teacher to offer feedback face-to-face in a class of 25 to 30 students, pupils liked knowing how they fared with speaking in a more immediate way. Wiggins (2012) noted that feedback is different from both evaluation and advice. Rather, true feedback is: a) goal-
oriented, b) tangible and transparent, c) actionable, d) user-friendly, e) timely, f) ongoing, and g) consistent. Moreover, the benefit of having diverse opportunities for feedback to enhance performance and achievement is corroborated by Hattie (2008). Therefore, for the students, the lab provided a much needed venue for timely feedback. When students participated in paired speaking exercises via the lab, for example, they received immediate feedback as their partner responded to their questions in the target language as well as when they answered questions of their partner.

**Cultural understanding.** Aside from speaking, I discovered that students loved learning about culture. With ReLANpro teachers uploaded various authentic videos and pictures reflecting culture as well as digital files of native speakers for students. One student indicated the program helped him better understand a native speaker in his Italian class. Another student stated the program helped her understand her mother’s Chilean language. Consequently, students engaged in cultural comparison, often comparing elements of Italian or Spanish culture to their own. Culture reflects one of the five themes in standards-based world languages education and is an essential component of students’ overall language learning experience.

**How do students describe their experience using the ReLANpro digital lab?**

**Practice.** It was evident students perceived that one of the main strengths of the program was it afforded practice with speaking. Krashen (1988) discussed the benefits of diversified practice with respect to comprehensible input and output in language learning. Additionally, standard 1.2 of the communication goal of the National Standards (1999) emphasizes that students’ control over what they hear and read has an impact on their
development of comprehension (Mills, Pajares, & Herron, 2006, p. 277). Consequently, when students took ownership of their own cognitive learning processes, their sense of self-efficacy improved. Moreover, Davies et al. (2011) further touted the importance of practice in language learning via technology-supported environments. Consequently, the lab provided students a way to practice speaking as well as learn different aspects of the language via multi-modal exercises.

**Language anxiety.** Students said that the program was “more laid back”, “more efficient”, and “less nerve-wracking” than speaking in front of the class or face-to-face with the teacher. Therefore, the program lowered students’ feelings of apprehension and allowed them to explore language learning in a more fun, hands-on way. Horwitz (2001) and Sheen (2008) described language anxiety as a real construct which could act as a true barrier to learning. Moreover, MacIntyre & Gardner (1994) interpreted language anxiety as the feeling of tension which can be caused by a specific situation or event (Ellis, 2008). While Young (1991) noted language anxiety could take various forms, Tallon (2011) indicated it could play a causal role in creating individual differences in language learning (p. 75). Thus, the lab offered students a safe way to practice and take language risks without fear of making a mistake in front of peers or the instructor. Many did acknowledge, however, that speaking in front of the teacher or peers was an important skill to have for a future career.

**Differentiated instruction.** Students spoke positively about using the lab to “hear their own voice” and enhance their language learning experience. Specifically, they grouped the lab with existing technology and programs such as Google Classroom, Quizlet Live, Gimkit, Duolingo, Flip Grid, Peardeck, and Kahoot which contributed to
their understanding of the language and made learning more enjoyable. This concept aligns with Prensky (2001) who contended that students, as digital natives, generally enjoy using technology in the classroom as part of their overall learning experience. As the ReLANpro program could be used for viewing, listening, speaking, writing, and reading activities and provided an entirely new format, it piqued students’ interest and promoted both student engagement and differentiated instruction. Tomlinson (1999) asserted that students are more engaged when the ways of learning are varied, and pupils can work at their own individual pace. In this sense, the program accomplished these aforementioned objectives.

**Interpersonal communication.** Using the paired speaking function, students engaged in interpersonal communication and learning which also bolstered their self-efficacy in language production. Learning with others and from others promoted positive acceptance and understanding of speaking tasks. For instance, students could be heard reminding their partner to use informal questions in lieu of formal in Italian class. Therefore, students recognized the importance of learning from others by listening to peers using the program and offering helpful advice.

*To what extent are students’ afforded language learning opportunities in speaking, writing, reading, and listening upon the use of ReLANpro as measured by artifacts?*

**Different pathways.** Throughout the two schools, students used the program in different ways. For instance, school A implemented more of the “Cloud” features of the program with listening/responding exercises and subtitling of video whereas school B implemented more of the “Class” features of the program with paired speaking exercises.
Therefore, students’ pathways to learning and opportunities varied from school to school primarily based upon teachers’ comfort level with various aspects of the program as well as the school’s infrastructure and network reliability.

*What are teachers’ perceptions of the effectiveness of the lab and recommendations for best practices in both training and implementation?*

**Benefits to students.** Teachers said that the benefits to students existed in certain areas. One area of benefit was in listening skills with 91 percent of teachers in agreement that the lab prompted students’ abilities in this regard. As listening skills are integral to being able to receive and process comprehensible input, this aspect was a very important strength to the program. The greatest area of strength was in speaking with 92 percent of teachers agreeing that the lab augmented students’ abilities in this area. With the primary goal in second language acquisition the production of comprehensible output for different purposes and audiences, this was a definite plus to the lab.

**Benefits to teachers.** Ninety-two percent of teachers said that the main benefit to the lab was it supported their formal assessment strategies. This was very telling as teachers struggle with time to assess students properly (Larson, 2000). Thus, the lab allowed teachers to add feedback during students’ paired speaking sessions as well as to access bookmarked student responses. Additionally, teachers could replay student responses to assess which often gets lost in face-to-face assessment methods. Moreover, teachers said that they could train students in the use of the lab as well as assist their peers with using the lab. In fact, 92 percent agreed to both of these tasks. This speaks to educator persistence and perseverance with blended learning solutions.
Areas of concern. Although 82% of teachers agreed with the overall benefits of the lab to students, they did not agree to all aspects of the lab and its implementation. For instance, 50% disagreed with its ease of use, and 75% of teachers disagreed with the professional training on the program. As there was only one introductory training and teachers did not have their rosters to create actual lesson sets, they were not able to internalize fully the program’s functionality and use it lab right away in the classroom. Also, the training consisted of all of the possible functions of the program which appeared overwhelming to the group as an introduction to the lab. Moreover, 58% disagreed with the technological assistance with the program. As there existed no technology director in the district to oversee the program’s implementation or building software technology specialists who were trained in the software to assist in the ongoing training of the teachers, teachers had to navigate the program more on their own and turn to other forms of training.

Teachers training teachers. Teachers’ persistence with the program was commendable. Despite not having all of the answers at their fingertips from the program’s inception, they found ways to be successful with the program. Teachers first created helpful user guides at each school. Then, lead teachers showed their peers how to create lessons and use different aspects of the program such as subtitling of video and paired speaking. Teachers from each school traveled to sister schools during common planning periods to share lessons and discuss the best ways to use the program given the district’s curriculum and the various levels of learners. Thus, teachers had problems to solve and then tapped on each other’s professional expertise to seek answers. The students were the benefactors of the teachers’ persistence as the teachers took more risks
using the program in their classes as a result of the collaboration and problem-solving efforts. Consequently, this positive byproduct was an unexpected result, yet it was very promising as was noticed in the Sorbie study (2015) with the development of professional learning communities. Moreover, although the study’s main focus was students’ self-efficacy in second language acquisition, grounded theory allowed for new revelations as was noticed in the teachers’ reactions to the program and subsequent actions to integrate the lab into instruction.

**Implications**

**Research.** Additional studies might be conducted to understand further student attitudes towards language learning and the effectiveness of language labs on students’ language acquisition. This study included different instructional levels with some students with IEPs, yet it did not include the lowest level of instruction. Therefore, a future study might include this population. Perhaps researchers could follow one world language class all year-long with the program, incorporating a pre and post assessment, to show a degree of change. The study could also incorporate protocols which gauge student persistence and/or resilience with the program. A subsequent study could include control and experimental groups with other marginalized populations. One group would have access to the lab and one would not, and researchers could administer a self-efficacy survey to both groups at specified periods of time as well as interview students to determine any influence on language learning.

Probably the most important potential area for future research involves the influence of teachers’ self-efficacy with implementing a digital language lab in the classroom on students’ self-efficacy. Teacher efficacy is a teacher’s belief that he or she
can influence desired student outcomes (Coladarci & Breton, 2001; Hoy & Spero, 2005; Soodak & Podell, 1996; Wheatley, 2005). Teachers with high self-efficacy welcome new methods of instruction and experiment with instructional materials (Allinder, 1994; Guskey, 1988; Stein & Wang, 1988). Consequently, teacher self-efficacy is critical to future research as students’ self-efficacy may be heightened when teachers believe their actions can positively influence student outcomes in learning. Hence, teachers with self-efficacy influence student achievement because they are more willing to take risks, implement new approaches, provide assistance to low-achieving students, increase student academic self-efficacy, set attainable goals for students, and persist when faced with student failure (Hoy & Spero, 2005; Tschannen-Moran & Hoy, 2001).

A study, in particular, that compares teachers with high self-efficacy, access to ReLANpro, and second language learners to those with lower self-efficacy, access to ReLANpro, and second language learners would be interesting to detect any noticeable differences in student language outcomes. The experimental group would be comprised of those teachers with higher levels of self-efficacy. The control group would be comprised of those teachers with lower levels of self-efficacy. The students’ year of study and instructional level would be identical for both groups. To determine teachers with high self-efficacy, researchers would need to develop appropriate measures and criteria ahead of time.

It is important to recognize that teacher self-efficacy research is valuable to explore, yet the subject can have complexities. Teacher self-efficacy, itself, is context-specific and can vary based upon the subject they are teaching, the students they are teaching, and the environment in which they are teaching (Goddard, Hoy, & Hoy, 2000).
In addition, a teacher’s age and years of experience may also be associated with changes in teacher self-efficacy (Sartawi & Alghazo, 2006). Nevertheless, analyzing the connection between teacher self-efficacy in implementing a digital resource and the influence on students’ self-efficacy using the resource to enhance language acquisition would be a worthwhile undertaking and contribute significantly to the field.

**Recommendations**

**Language lab implementation and transformational leadership.** Implementing a resource such as a lab takes time, energy, coordination, and planning (Brooke, 2015). Districts that may benefit in investing in such a resource might be those that have not been able to offer students fully articulated programs across grade levels and are seeking ways to encourage pupil contact time with a language to build proficiency. These districts should have a technology supervisor or director available to ensure the proper support equipment such as specialized headphones are ordered as well as to troubleshoot any issues that may arise. Also, districts that have poor infrastructures and unreliable networking may opt for other solutions.

When actually implementing a digital language lab program, districts should follow a strong implementation model which includes teachers turnkey training to ensure the transition is a smooth one. For instance, schools should begin with a small group of teachers, administrators, and students whose task is to establish set criteria for an effective program and consider various blended resources. The group should fully research specific resources fitting the established criteria and visit districts outside of the school to observe, ask questions of the varied stakeholders regarding the program’s effectiveness, and debrief on these initial findings. If it is determined a specific resource
fits the needs of the school system, then it should be piloted for at least a year with different populations of students. At the end of the year, the original team should then reconvene to determine the effectiveness the program for the various stakeholders.

Some possible questions educators may opt to explore include: 1) does the program serve the unique needs of teachers and students (user-friendly, multi-modal, and technological compatibility, etc.), 2) does the program positively affect student learning outcomes?, and 3) in what way(s) does the program support the curriculum? If the group determines the program is worth pursuing, the team should devise a full-fledged professional training program or plan to in-service staff. Yoon, Duncan, Lee, Scarloss, and Shapley (2007) found throughout three studies that professional development lasting 14 or fewer hours shows no effects on learning – the largest effects are for programs offering 30-100 hours spread out over six to twelve months. For that reason, a sufficient amount of time should be devoted to teacher training on an ongoing basis. The original group of teachers should be fully trained, followed by the training of the whole staff. The professional development model should focus primarily on teachers training teachers in a turnkey format with periodic trainings by the technology staff.

There exist some other necessary steps for success with implementation. Administrators should be fully trained in the program, so they know all of the various functions which can be used by teachers and possible connected student outcomes. This way, they will be prepared when observing teachers and ultimately making instructional recommendations related thereto. Additionally, the training should include what the “teacher will see and do” as well as what the “student will see and do.” It is important for
educators to be able to see things from different perspectives to be truly effective and have the know-how to act as change agents and transformational leaders.

Conclusions

While no program is completely free of technical issues, it is still important for districts to pursue blending learning formats to support the needs of their own, unique world language programs to enrich students’ learning experience, individualize instruction, provide diverse practice opportunities, and promote safe venues for students to hear their own voice on their pathway to proficiency. In conjunction with districts pursuing blended learning options, they must be mindful of teachers’ existing knowledge and comfort level with technology, the various levels of risk takers, professional development planning, and different levels of resilience among staff. As noted, with blending learning the teacher’s lesson plan and know-how can alter student outcomes in language learning. For this reason, implementing programs in a very precise manner with ongoing training, support, and time for articulation is key to maximizing the overall usage of the resource and ultimately different opportunities or new pathways to learning afforded the learner.
References


Romeo, Kenneth; Bernhardt, Elizabeth B; Miano, Alice; Leffell, Cici Malik. Foreign Language Annals; Alexandria Vol. 50, Iss. 4, (Winter 2017): 681-696.


Appendix A

Definitions of Key Terminology

*Advanced-Low Level Learners.* Students who communicate using paragraph-level discourse to handle complicated situations on a wide-range of topics.

*Affective Filter.* The complex of negative emotional and motivational factors that may interfere with the reception and processing of comprehensible input. Such factors include: anxiety, self-consciousness, boredom, annoyance, and alienation (Krashen, 1983).

*Articulation.* The smooth transition from one level of proficiency to the next along the continuum of language learning.

*Audio-Lingual Method (ALM).* A method of foreign language teaching which emphasizes the teaching of listening and speaking before reading and writing. It uses dialogues as the main form of language presentation and drills as the main training techniques (Levy, 1997).

*Authentic Assessment.* Tasks that evoke demonstration of knowledge and skills in ways applied in the real world.

*Blended Learning.* An instructional format in which traditional face-to-face methods or direct instruction is augmented by technology. The technological tools can be varied, yet typically refer to online learning (Pegrum, 2009).

*Bring Your Own Device Mobile-Assisted Language Learning (BYOD MALL).* Today students are now using their own electronic devices to interact with digital files teachers create and upload their work as well. This allows for more flexibility in both learning and assessment (Burston, 2017).
Appendix A

Definitions of Key Terminology (Continued)

*Circumlocute*. With circumlocution, students use speech that circles around an idea with many words instead of stating it directly. This act keeps speech or the conversation moving while the student searches for the right words in his or her head.

*Communities of Practice (CoP)*. A CoP can evolve naturally because of the members' common interest in a particular area, or it can be created with the goal of gaining knowledge related to a specific field. It is through the process of sharing information and experiences with the group that members learn from each other, and have an opportunity to develop personally and professionally (Lave & Wenger, 1991).

*Comprehensible Input*. Language input that can be understood by listeners despite them not understanding all the words and structures in it. It is described as one level above that of the learners if it can only just be understood (Krashen, 1988).

*Comprehensible Output Hypothesis*. The supposition that second language acquisition depends on more than just comprehensible input and requires learners to produce the language.

*Computer-Assisted Language Learning (CALL)*. Computer-assisted language learning (CALL) is an approach to language teaching and learning in which computer technology is used as an aid to the presentation, reinforcement and assessment of material to be learned, usually including a substantial interactive element.
Appendix A

Definitions of Key Terminology (Continued)

*Culturally Authentic Material.* Books, tapes, videos, games, and realia that have been produced for use by native speakers of the target language.

*Digital Natives.* Students, growing up in a time of varied online, digital, and social media, are very accustomed to using this sort of technology to communicate. Older adults are considered “digital immigrants” (Prensky, 2001).


*Fluency.* Fluency is typically a term reserved for native speakers. It refers to a person’s ability to: 1) understand with ease virtually everything heard or read, 2) summarize information from different spoken and written sources, reconstructing arguments and accounts in a coherent presentation, and 3) express himself or herself spontaneously, very fluently and precisely, differentiating finer shades or nuances of meaning even in the most complex situations.

*Formative Assessment.* Ongoing evaluation of a student’s progress during a learning activity that is used to inform instruction and assists in tracking student progress. It is often referred to as assessment for learning.

*Immersion.* A method of teaching a foreign language by the exclusive use of that language. ACTFL recommends that educators use the target language in the classroom at least 90% of the time. Also, students, who have spent time in a foreign country, are immersed in the language. Being immersed in the language, students tend to grasp the language more quickly.
Appendix A

Definitions of Key Terminology (Continued)

*Intermediate-High Level Learner.* Students communicate using connected sentences and paragraphs to handle complicated situations on a wide-range of topics.

*Intermediate-Mid Level Learner.* Students communicate using strings of sentences to ask and answer questions, to handle simple transactions related to everyday life, and to talk about subject matter studied in other classes.

*Intermediate-Low Level Learner.* Students communicate using simple sentences to ask and answer questions, to handle simple transactions related to everyday life, and to talk about subject matter studies in other classes.

*Language Function.* A function that can be facilitated with language to meet a communicative purpose. Some examples include: greeting, leave taking, describing, and persuading.

*Language Learning.* Language learning is considered different from acquisition in the sense that it is more conscious, and it is focused on learning objectives tied specifically to the curriculum. It is also more planned and focused, unlike acquisition which is more spontaneous in nature.

*Mobile-Assisted Language Learning (MALL).* Mobile-assisted language learning (MALL) is language learning that is assisted or enhanced through the use of a handheld mobile device. With MALL, students are able to access language learning materials and to communicate with their teachers and peers at any time, anywhere.
Appendix A

Definitions of Key Terminology (Continued)

_Modeling._ The act of providing an example of what to do and how to do it; modeling helps to ensure that practice will take place as planned.

_Modes of Learning._ ACTFL recognizes three modes of learning (interpretive, interpersonal, and presentational). The interpretive mode refers to one-way communication and is the way written or spoken utterances are received and interpreted. The interpersonal mode is characterized by the active negotiation of meaning among individuals, either listeners and speakers, or readers and writers. The presentational mode is one-way communication in which a speaker communicates to many listeners. Thus, it refers to the creation of formal messages to be interpreted by listeners or readers without opportunity for the active negotiation of meaning.

_Multi-modality._ A theory of communication and social semiotics which describes communication practices in terms of the textual, aural, linguistic, spatial, and visual resources, or modes, used to compose messages.

_Multiple Intelligences._ A theory that individuals can learn in multiple ways and may demonstrate strength in one or more learning modalities (Gardner, 2004).

_NCSSFL-ACTFL Can-Do Statements Progress Indicators for Language Learners._ The statements help learners identify what they need to do to function at different proficiency levels and provide learners with the opportunity to set goals.

_Novice-High Level Learner._ Students communicate using words, lists, and simple sentences to ask and answer questions, to handle simple transactions related to everyday life, and to talk about subject matter studies in other classes.
Appendix A

Definitions of Key Terminology (Continued)

*Novice-Mid Level Learner.* Students communicate using memorized words and phrases to talk about familiar topics related to school, home, and the community.

*Oral Proficiency Interview (OPI).* The ACTFL Oral Proficiency Interview (OPI) is a valid and reliable means of assessing how well a person speaks a language. It is a 20-30 minute, one-on-one interview between a certified ACTFL tester and an examinee. The interview is interactive and continuously adapts to the interests and abilities of the speaker. The speaker’s performance is compared to the criteria outlined in the ACTFL Proficiency Guidelines 2012 - Speaking or the Inter-Agency Language Roundtable Language Skill Level Descriptors – Speaking. The interview is double rated and an Official ACTFL Oral Proficiency Certificate stating the candidate’s proficiency level is issued to the candidate.

*Proficiency.* Proficiency refers to a person’s ability to produce the language in different contexts and situations to communicate a message or messages. ACTFL developed a proficiency scale which is based on the Federal Government’s (Interagency Language Roundtable) ILR scale. ACTFL’s proficiency scale has four main levels (novice, intermediate, advanced, and superior) with three sublevels (low, mid, and high). Descriptors for each level have been defined by ACTFL.

*Reciprocal Causation.* A term introduced by Albert Bandura to refer to the mutual influence between three sets of factors: personal factors (e.g., cognitive, affective and biological events), the environment, and behavior.
Appendix A

Definitions of Key Terminology (Continued)

Second Language Acquisition (SLA). The process by which people learn a second language. A main factor driving SLA is the amount of time learners are immersed in the language and the input they receive. Acquisition is more a subconscious process.

Self-efficacy. A term coined by Bandura (1977) which refers to one's belief in his or her ability to succeed in specific situations or accomplish a task.

Talk Aloud. A strategy that involves reporting how a task is approached and completed.

Target Language. The target language refers to the second language of study or L2.

Technology-Enhanced Language Learning (TELL). The use of the computer as a technological innovation to display multimedia as a means of complementing a teaching method language teachers. TELL is not a teaching method but rather an approach that can be used alongside a teaching method to help teach. TELL is very supportive of Computer Mediated Communication (CMC).

The Center for Applied Linguistics. The Center for Applied Linguistics (CAL) is a private, nonprofit organization founded in 1959 and headquartered in Washington, DC. CAL's mission is to promote language learning and cultural understanding by serving as a trusted source for research, resources, and policy analysis.

The Teacher Effectiveness for Language Learning Project (TELL Project). This project is a collection of products and processes that world language educators can use to enhance their effectiveness as teachers and leaders. The foundational piece is the Teacher
Appendix A

Definitions of Key Terminology (Continued)

Effectiveness for Language Learning Framework, which establishes those characteristics and behaviors that model teachers exhibit. The Framework consists of 7 domains (Learning Environment, Planning, Teaching the Lesson, Assessment, Resources, Collaboration, Professionalism) organized around the three competency standards of the National Board for Professional Teaching Standards: Preparing for Student Learning, Advancing Student Learning, Supporting Student Learning.

Twenty-first Century Technologies. Technologies for students to interact with people from other cultures and to experience authentic cultural products and practices. Some of these include: digital tools (applications and software that aid in communication, video conferencing, texting, and IMing); electronic information sources (audio, video, and text available through a virtual format, podcasts, videocasts, audio clips, and websites); multimedia rich presentations (combination of text, audio, still images, video, interactivity, and animation); and, virtual sharing (social community/educational site, electronic poster, or webpage).
Appendix B

Student Survey

Language of Study _____________________

Please read each item and answer strongly disagree, disagree, neutral, agree, or strongly agree.

Course Content

<table>
<thead>
<tr>
<th>I feel confident….</th>
<th>SD</th>
<th>D</th>
<th>N</th>
<th>A</th>
<th>SA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. As a learner in this course.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>2. Accurately completing class assignments.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>3. Speaking aloud in the language.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>4. Writing the language.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>5. Listening to the language.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>6. Reading the language.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>7. Using different verb tenses.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>8. Participating in group projects.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>9. Understanding course material.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
</tbody>
</table>

With ReLANpro..

<table>
<thead>
<tr>
<th>I feel confident….</th>
<th>SD</th>
<th>D</th>
<th>N</th>
<th>A</th>
<th>SA</th>
</tr>
</thead>
<tbody>
<tr>
<td>10. Understanding the functions.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>11. Recording my speech.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>12. Writing subtitles to video.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>13. Speaking with classmates (headsets).</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>14. Practicing the language.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>15. Listening to the language.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
<tr>
<td>16. Reading the language.</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
<td>___</td>
</tr>
</tbody>
</table>
## Appendix B

### Student Survey (Continued)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>17.</td>
<td>Listening to my teacher’s prompts and responding.</td>
</tr>
<tr>
<td>18.</td>
<td>Using the chrome book with the app.</td>
</tr>
<tr>
<td>19.</td>
<td>Using my phone to access assignments.</td>
</tr>
<tr>
<td>20.</td>
<td>In the dependability of the software.</td>
</tr>
</tbody>
</table>
Appendix C

Teacher Questionnaire

Language Taught ____________________ Instructional Level ____________________

Please read each item and answer strongly disagree, disagree, neutral, agree, or strongly agree.

With ReLANpro…

I feel confident:

1. In the dependability of the system. ______ ______ ______ ______ ______
2. In teaching students how to use the system. ______ ______ ______ ______ ______
3. In the benefits of the system. ______ ______ ______ ______ ______
4. In the versatility of the system. ______ ______ ______ ______ ______
5. In the professional training received on the system. ______ ______ ______ ______ ______
6. In the technology assistance with the system. ______ ______ ______ ______ ______
7. In the manner the system supports students’ speaking skills. ______ ______ ______ ______ ______
8. In the manner the system supports students’ writing skills. ______ ______ ______ ______ ______
9. In the manner the system supports students’ listening skills. ______ ______ ______ ______ ______
10. In the manner the system supports students’ reading skills. ______ ______ ______ ______ ______
11. In the manner department members have assisted one another with the system. ______ ______ ______ ______ ______
12. In the manner the system has supported my formal assessment strategies. ______ ______ ______ ______ ______

What are some of the activities or lessons you have been able to do with ReLANpro?
Appendix D

Observation Protocol

Class – Spanish or Italian – circle one

School A or School B – circle one

Today’s Date ______________

Level – Advanced Placement, Accelerated, Honors, College Prep, or Modified – circle one

1. In what ways are the students using the ReLANpro lab (recording individual speech, paired speaking, listening, reading, or writing)?

2. Do the students appear engaged with the program? Do the students look focused on the task at hand?

3. Is there momentum to the lesson when the technology is used?

4. Are the students using the lab with chrome books in the classroom or on media center computers?

5. How do the students react when the teacher informs the group they will be using the digital language lab?

6. In what ways are the assigned tasks or activities supporting the curriculum?

7. In what ways are the assigned tasks or activities supporting the specific mastery objective?

8. Is the lab being used to activate learning, assess understanding, reinforce understanding, encourage peer-to-peer communication, or other?

9. In what ways are the assigned tasks or activities supporting second language acquisition?
Appendix E

Student Interview Protocol

Spanish or Italian student – circle one

School A or School B – circle one           Today’s Date ______________

Level – Advanced Placement, Accelerated, Honors, College Prep, or Modified - circle

1. Do you like learning a world language? What do you like the best? What do you like least?

2. How do you learn best in Italian/Spanish class? What ‘works’ for you? What lessons or activities do you enjoy the most?

3. Do you like using different forms of technology in class? If so, which types?

4. How have you used ReLANpro digital language lab in the classroom? In the media center?

5. To what extent do you think the program is easy to use?

6. What effect has using ReLANpro had on you (on your attitude to SLA) (on your language learning)?

7. Has the program made you feel more confident in your use of the language?

8. Has the program motivated you to produce more in the target language/be more creative in your oral/written production in the target language?

9. Has the program helped you figure out your strengths and weaknesses as a language learner?

10. Is there any aspect of learning a language that brings you anxiety?
Appendix F

Student Directions on Media Center Computers School A

1. Log on
2. Open internet browser and go to: lrhsd.relanpro.net
3. In the first blank, next to the number 7421, type in your student ID. Then, type in the password students.
4. You will be prompted to make your own password. Please do so.
5. Close the internet browser.
6. Plug in your headset.
7. Open “Standalone NET recorder” icon on your desktop and open it. (It is green).
   Type in **School ID:** 7421 **Student ID:** Your personal ID number **Password:** your newly made password
8. There will be TWO lesson sets: **Intro conversation** AND **Intro convo – FORMAL**
9. Double-click on **Intro conversation**
10. Double-click **intro convo.mp3**
11. You may the play recording, which contains all of the instructions for completing the assessment.
12. When you have successfully recorded your responses, please click the **SUBMIT** button and complete the next task: **Intro convo – FORMAL**.
Appendix G

Student Directions Classroom on Chrome books School A

ReLANpro Cloud & Class

COMPUTER/CHROME BOOK:

LOG IN TO RELANPRO ONLINE:

1. Go to lrhsd.relanpro.net
2. Enter your Student ID number.
3. Enter your temporary password: students
4. Go to “My account” tab.
5. Change your password. (Be sure to write it down somewhere so that you remember it.)
6. Click “save”.

RELANPRO APP: (Student Recorder)

1. If using ChromeBook, search for ReLANpro app. (Green circle)
2. Log in with Student ID and new password.
3. SCHOOL CODE: 7421
4. Click on *language* & Find Lessonset.
5. Listen to directions.
6. When ready to record your answers, hit the GAP button.
7. Click SUBMIT when you are ready to turn it in.

ReLANpro Cloud & Class

LOG IN TO RELANPRO ONLINE:

1. Go to lrhsd.relanpro.net
2. Enter your Student ID number.
3. Enter your temporary password: students
4. You will be prompted to change your password.
5. Change your password. (Be sure to write it down somewhere so that you remember it.)
6. Click SAVE.
7. Close the window, you will now be working in the reLANpro App.
Appendix G

Student Directions Classroom on Chrome books School A (Continued)

RELANPRO APP: (Student Recorder)

1. If using ChromeBook, search for ReLANpro app. Click the circle at the
top left corner of your screen. Go to the Web Store and search “reLANpro
Student Recorder”. Add to Chrome.
   If using Phone, go to App Store, and download reLANpro Student Recorder
   App.
   If using a LRHSD Desktop, the App should already be installed on the
desktop.
2. Log in with Student ID and new password.
3. SCHOOL CODE: 7421
4. Click on *language* & Click on Lessonset.
5. Click on .mp3
6. Click PLAY to listen to the entire assignment. Click STOP at the end.
7. When ready to record your answers, Click the RECORD button.
8. After you hear the first question, click the GAP button, speak your response,
then Click the GAP button again. You will then hear the second question.
   Click the GAP button, speak your second response, then Click the GAP button
   again. You will Click GAP before and after each response.
9. When you have finished recording, Click STOP. You can then DELETE or
   SUBMIT. You cannot delete just part of your recording, you have to start over
   from the beginning.
10. Click SUBMIT when you are ready to turn it in.
Appendix H

Teacher User Guide for ReLANpro School A

TO ADD YOUR CLASSES TO ReLANpro:
1. Go to the Website lrhsd.relanpro.net
2. Log in.
3. Click My classes → Click Add.
4. Scroll to find your class code
   Ex. All Shawnee classes start with “0002”, AP Italian is “258/1”, so to find the AP Italian Class, look for “00022581”.
5. Click on the box next to the class you want to add → Click Add.
   You can add multiple classes at once, just click on all of the boxes you want to add → Click Add.
   Your class(es) are now added to reLANpro.
6. If you are missing a student from a class, go to next section to add that student to the class.

TO ADD A STUDENT TO A CLASS:
1. Go to the Website lrhsd.relanpro.net
2. Log in.
3. Click My classes → Click on the green Students button next to the class to which you want to add the student.
4. Click Add → Scroll to the student you want to add.
5. Click on the box next to the student’s name → Click Add

TO CREATE A GAP SPEAKING ASSIGNMENT:
1. Create the Lessonset by logging in on Website.
2. Click Lessonsets → Click Add → Click New
3. Name it and Save it.
4. Go to Cloud Manager → Click Lessonsets
5. Click Lessonset you want to work with.
6. Click Files button and click microphone at the bottom.
7. Now you can record your prompt (sample student directions below).
8. Click Submit. (Click Save if you want to save the assignment to H-Drive.)
9. Go back to Website: Click Classes → Click Add → Click Lessonset → Click Class
10. Now your speaking prompt has been assigned to a class.

SAMPLE STUDENT DIRECTIONS:
Listen and respond to the following prompts. Listen to the first prompt, and then click the Gap button to respond. Click the Gap button again when you have completed your response. You will then hear the 2nd prompt. Now begin.
Appendix H

Teacher User Guide for ReLANpro School A (Continued)

TO CHECK STUDENT ANSWERS:
1. Go to Cloud Manager.
2. Click on the Class.
3. Click on assignment.
4. Click on Files to view students’ answers.

When listening to responses – hit the Bookmark button to listen to just the student’s speaking portion.
Appendix I

Teacher User Guide for ReLANpro School B

RELANPRO CLASS
USER GUIDE
5 BASIC ACTIVITIES

CREATED BY:
MR. O
MR. G
MRS. H

Class basics - things you need to know for any activity...
To use the language lab:
• select the ReLANpro Icon on the desktop
• School ID is 7421
• Enter your ReLANpro user name and password

You will see the following menu

• Click on Class Manager.
• Click on “Your Classes”
• Select the class in the Lab today and hit “Create”

All students who have logged into the program will appear “Dark Purple” on
Appendix I

Teacher User Guide for ReLANpro School B (Continued)

the right hand side of the Class application. Make sure to maximize the window.

- Select all students by clicking in the light purple area below the list of students. You may also select the students individually by clicking on their names if you’d like. Once you have done that, they will become highlighted -- this means they are active and ready for the day’s activities.

- If students are not selected/highlighted, they cannot participate in any activity. Likewise, if they arrive late to class, you must return to this screen and manually select them once they have logged in.
Appendix J

Student Survey Responses

Language of Study
27 responses

Level of Study
27 responses

Year of Course (ex. Year 3 = Spanish 3)
27 responses
Appendix J

Student Survey Responses (Continued)
Appendix J

Student Survey Responses (Continued)

I feel confident writing subtitles to video.
27 responses

I feel confident speaking with classmates (using headsets for paired speaking).
27 responses

I feel confident recording my speech.
27 responses
Appendix J

Student Survey Responses (Continued)

Course Content

I feel confident as a learner in this course. (Answer 1 - strongly disagree, 2 - disagree, 3 - neutral, 4 - agree, and 5 - strongly agree)

27 responses

With the ReLAnpro language lab...

I feel confident understanding its different functions (capabilities).

27 responses
Appendix J

Student Survey Responses (Continued)
Appendix J

Student Survey Responses (Continued)

I feel confident using different verb tenses.

27 responses

I feel confident accurately completing class assignments.

27 responses

I feel confident in the dependability of the ReLANpro system software.

27 responses
Appendix J

Student Survey Responses (Continued)

I feel confident using my phone to access ReLANpro assignments.
27 responses

I feel confident using the chromebook with the ReLANpro app.
27 responses

I feel confident listening to my teacher's prompts (questions) and responding.
27 responses
Appendix J

Student Survey Responses (Continued)
Appendix K

Teacher Usage and Administrator View of ReLANpro
Appendix K

Teacher Usage and Administrator View of ReLANpro (Continued)
### Appendix K

**Teacher Usage and Administrator View of ReLANpro (Continued)**

<table>
<thead>
<tr>
<th>Administrator Configuration</th>
<th>Languages</th>
<th>Lessons</th>
<th>Students</th>
<th>Classes</th>
<th>Teachers</th>
<th>Assignments</th>
<th>Students students</th>
<th>Download</th>
<th>Assignments</th>
<th>students</th>
<th>DOWNLOADS</th>
<th>Import students students / classes teachers</th>
<th>User</th>
<th>Login</th>
<th>Administrator</th>
<th>Login</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Rabbit: Grade

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Class</th>
<th>Added</th>
<th>Expires</th>
<th>Time</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week 1</td>
<td>12/3/2019</td>
<td>0</td>
<td>15</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Week 2</td>
<td>12/3/2019</td>
<td>0</td>
<td>15</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

#### Trolley: Name

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Class</th>
<th>Added</th>
<th>Expires</th>
<th>Time</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name 1</td>
<td>12/3/2019</td>
<td>0</td>
<td>15</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Name 2</td>
<td>12/3/2019</td>
<td>0</td>
<td>15</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

#### Next Page

170
Appendix K

Teacher Usage and Administrator View of ReLANpro (Continued)
Appendix L
ReLANpro Visitation March 2019

ReLANpro visitation
March 6, 2019
Day 3

Start in Classroom 4 in Media Center

**Class 3 (7:20-8:22)**
- Italian ⅔ H (24)
- Spanish 4 ACC (17)

Class/ Paired Speaking activity
Can pairs be set up correctly?
Can audio be saved?
Can we set up video pairs?
Why can writing activities only be done in the Class?
When writing: No accent marks / comments/ feedback
What about tips/tools/examples on social media or website/blog
User manual?

**Class 4 (8:27-9:24)**
Common Planning Time

**Class 1 (9:29-10:26)**
Duty
SH Cafe

**Lunch and Learn (10:26-11:16)**
Break

**Class 7 (11:16-12:13)**
- Italian ⅔ H (21)
- Spanish 2 ACC (21)

**Class 8 (12:18-1:15)**
- Italian 4 H (20)
- Spanish 1 ACC (27)

**Class 5 (1:20-2:17)**
- Italian 4 (19)
- Spanish 1 ACC (30)
Appendix L

ReLANpro Visitation March 2019 (Continued)

1. What are other aspects of ReLANpro that we are not utilizing? ReBrowser, ReABC Create etc.? Can any of these things be used on the Cloud?

When you click on Class Manager it gives you access to:

- From this window using Recorder, can you send a Lessonset (as we use on the Chrome books) to students who are logged in? How do you use it?

- Using ReCall, you can pair students either through Audio or Video. However, when we click on it, we get the following:

Which does not allow the save button to be used. It also does not give access to video once you hit audio.

- Using ReChat, you can pair students to write to each other, and the save button is able to be used:
Using ReBrowser, you can send a website to student stations:

- If you click on Cloud Manager on the upper left, you get access to your Classes, Students and Lessonsets:
What can you do from here? Can you send a Lessonset to student stations? If so, why not just use Recorder (but we don’t get how that works either)?

- If you click on Tool Manager on the upper left, you get this:

What can you do from here?

2. Is there an easier way to do subtitles (uploading a video) rather than Screengrab?

3. Error codes?
Appendix L

ReLANpro Visitation March 2019 (Continued)

Desktop:

Chromebook:
Appendix M

Teacher Directions for ReLANpro upon Visitation

TO ADD YOUR CLASSES TO ReLANpro:

1. Go to lrhsd.relanpro.net
2. Log in.
3. Click My classes → Click Add.
4. Scroll to find your class code
   Ex. All Shawnee classes start with “0002”, AP Italian is “258/1”, so to find the
   AP Italian Class, look for “00022581”.
5. Click on the box next to the class you want to add → Click Add.
   You can add multiple classes at once, just click on all of the boxes you want to
   add → Click Add.
6. Your class(es) are now added to reLANpro.

TO ADD A STUDENT TO A CLASS:

1. Go to lrhsd.relanpro.net
2. Log in.
3. Click My classes → Click on the green Students button next to the class to which
   you want to add the student.
4. Click Add → Scroll to the student you want to add.
5. Click on the box next to the student’s name → Click Add

TO CREATE A WRITING ASSIGNMENT (students must take on PCs, NOT
Chrome books):

1. Open word and create the assignment. You must save as RICH TEXT
   FORMAT (RTF).
   (To save as a RTF – use drop down menu titled “Save as type” to find Rich Text
   Format) → Click Save
2. Go to www.lrhsd.relanpro.net
3. Log in.
4. Click Lessonsets → Click Add → Click New.
5. Name Lessonset → Pick Language → Click Save.
6. Go to Classes under Assignments → Click Add → Click Lessonset (choose the
   Lessonset you just created on dropdown menu) → Click Class (Choose the class
   you want on dropdown menu) → Click Save
7. Go to CLOUD MANAGER (app) → Click Lessonset → Double click the Lessonset
   you just created.
8. Click Folder Icon at bottom to upload the file you want to use → Click Open
Appendix M

Teacher Directions for ReLANpro upon Visitation (Continued)

TO CREATE A GAP SPEAKING ASSIGNMENT:

1. Create the Lessonset by logging in on website.
2. Click Lessonsets → Click Add → Click New
3. Name it and Save it.
4. Go to Cloud Manager → Click Lessonsets
5. Click Lessonset you want to work with.
6. Click Files button and click microphone at the bottom.
7. Now you can record your prompt.
8. Click Submit. (Click Save if you want to save the assignment to H-Drive.)
9. Go back to Website: Click Classes → Click Add → Click Lessonset → Click Class
10. Now your speaking prompt has been assigned to a class.

SAMPLE STUDENT DIRECTIONS:

Listen and respond to the following prompts. Listen to the first prompt, and then click the Gap button to respond. Click the Gap button again when you have completed your response. You will then hear the 2nd prompt. Now begin.

TO CREATE A MULTIPLE CHOICE OR OPEN ENDED ASSIGNMENT (students must take on PCs, NOT Chrome books):

1. Open the reABC Create App
2. Click either Multiple-choice or Open question
3. Click either AB2 files for Windows or ABX files for Macintosh and Windows (as far as I can tell they both work the same)
4. For both Multiple-choice and Open question, type your prompt in the top box.
5. For Multiple-choice, type the four possible answers in the boxes underneath.
6. For Open question, type the required answer in the box underneath. If there are TWO possible answers, type them in separate boxes underneath.
7. Click on Save (looks like a floppy disk) and save to your H-drive or computer.
8. To upload to ReLANpro, follow steps 4-10 under “To Create a Gap Speaking Assignment”.

TO CHECK STUDENT ANSWERS:

1. Go to CLOUD MANAGER
2. Click on the Class.
3. Click on assignment.
4. Click on Files to view students’ answers.
Appendix M

Teacher Directions for ReLANpro upon Visitation (Continued)

When listening to responses – hit the Bookmark button to listen to just the student’s speaking portion.

CLASSROOM DIRECTIONS:

1. Teacher must use ReLANpro headsets, plugged in back of computer.
2. All student headsets must be plugged into the back of the computer. There are 4 USB ports together on the back and it goes in the top left if open. If that port is not open, it goes in Top Right.
3. Open RelanTeacher (Purple Icon)
4. Click the Log Request button on the left, so that students can type in their first and last names (autopopulates with student IDs). On the right hand side of screen, you will see all the students’ ID numbers who are logged on to a computer in Classroom 4. There is a side arrow to click to open up and see all of your students.
5. Click arrow to open up and see entire class.
6. Click the light purple space underneath the names to highlight all their names. Names should now be white and that means they are part of the pairing.
7. Click on the green button under ReCall. (This is for paired speaking /text messaging)